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NOTICE

A hardware change was made to TripSaver II Cutout-Mounted Reclosers manufactured after October 2022 that are 
factory-loaded with firmware version 2 .0 . A new model of the USB transceiver firmware version 2 .0 (part number 
FDA-1868R2) is also available with an enhanced antenna . USB transceiver firmware version 2 .0 is required to 
connect to TripSaver II reclosers with firmware version 2 .0 . USB transceiver version 2 .0 is backward compatible with 
all TripSaver II recloser firmware versions .

A USB transceiver with firmware version 1 .6 can be used with the latest version of the service center configuration 
software and TripSaver II reclosers with firmware version 1 .9 and earlier . To connect to TripSaver II reclosers with 
firmware version 2 .0, USB transceivers must be upgraded to firmware version 2 .0 . This can be done using the 
latest version of the service center configuration software . See the “USB Transceiver Firmware Update” section 
on page 43 .

Because of a hardware change, TripSaver II reclosers with firmware version 1 .0 can only be upgraded to version 
1 .3 using the latest version of the service center configuration software . With the October 2022 hardware change, 
TripSaver II reclosers with firmware versions 1 .5 through 1 .8 can be upgraded to firmware version 1 .9 using the latest 
version of the service center configuration software, but they cannot be upgraded to firmware version 2 .0 .
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Introduction

 WARNING

Only qualified persons knowledgeable in the installation, operation, and maintenance 
of overhead and underground electric distribution equipment, along with all 
associated hazards, may install, operate, and maintain the equipment covered by this 
publication . A qualified person is someone trained and competent in:

 ● The skills and techniques necessary to distinguish exposed live parts from 
nonlive parts of electrical equipment

 ● The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

 ● The proper use of special precautionary techniques, personal protective 
equipment, insulated and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this 
type of equipment .

NOTICE

Thoroughly and carefully read this instruction sheet and all materials included in 
the product’s instruction handbook before installing or operating your <Product 
Name Here> . Become familiar with the Safety Information page 4 and Safety 
Precautions on page 5 . The latest version of this publication is available online in 
PDF format at sandc .com/en/contact-us/product-literature/ .

This instruction sheet is a permanent part of the TripSaver II Cutout-Mounted Recloser. 
Designate a location where users can easily retrieve and refer to this publication.

 WARNING

The equipment in this publication is only intended for a specific application . The 
application must be within the ratings furnished for the equipment . Ratings for the 
TripSaver II Cutout-Mounted Recloser are listed in the ratings table in Specification 
Bulletin 461-33 .

Qualified Persons

Read this 
Instruction Sheet

Retain this 
Instruction Sheet

Proper Application

http://sandc.com/en/contact-us/product-literature/
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Safety Information

Several types of safety-alert messages may appear throughout this instruction sheet and on 
labels attached to the TripSaver II Cutout-Mounted Recloser or in the TripSaver II Service 
Center Configuration Software. Become familiar with these types of messages and the 
importance of these signal words:

 DANGER

“DANGER” identifies the most serious and immediate hazards that will likely result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

 WARNING

“WARNING” identifies hazards or unsafe practices that can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed .

 CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE

“NOTICE” identifies important procedures or requirements that can result in product or 
property damage if instructions are not followed .

If any portion of this instruction sheet is unclear and assistance is needed, contact the 
nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are 
listed on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center 
at 1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully before 
installing or operating the TripSaver II Cutout-Mounted 
Recloser . 

If additional copies of this instruction sheet are required, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be 
replaced immediately. Replacement labels are available by contacting the nearest S&C 
Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding 
Safety-Alert 
Messages

Following Safety 
Instructions

Replacement 
Instructions 
and Labels

http://sandc.com
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Safety Precautions

 DANGER

The TripSaver II Cutout-Mounted Reclosers operate at high voltage . Failure to observe 
the precautions below will result in serious personal injury or death .

Some of these precautions may differ from your company’s operating procedures and rules . 
Where a discrepancy exists, follow your company’s operating procedures and rules .

1 . QUALIFIED PERSONS . Access to TripSaver II 
Cutout-Mounted Reclosers must be restricted only 
to qualified persons . See the “Qualified Persons” 
section on page 3 . 

2 . SAFETY PROCEDURES . Always follow safe 
operating procedures and rules .

3 . PERSONAL PROTECTIVE EQUIPMENT . Always 
use suitable protective equipment, such as rubber 
gloves, rubber mats, hard hats, safety glasses, and 
flash clothing, in accordance with safe operating 
procedures and rules .

4 . SAFETY LABELS . Do not remove or obscure 
any of the “DANGER,” “WARNING,” “CAUTION,” 
or “NOTICE” labels and tags . Remove tags only if 
instructed to do so .

5 . ENERGIZED COMPONENTS . Always consider all 
parts live until de-energized, tested, and grounded .

6 . OPERATING TOOLS To close a TripSaver II 
Cutout-Mounted Recloser, use a conventional 
insulated hotstick or S&C Universal Pole and 
Pole Extension fitted with a Talon™ Handling Tool 
or distribution prong . An extendo stick also can 
be used after proper training and practice . The 
TripSaver II Cutout-Mounted Recloser can be 
opened using Loadbuster® —The S&C Loadbreak 
Tool attached to a conventional insulated hotstick or 
S&C Universal Pole .

7 . MAINTAINING PROPER CLEARANCE . Always 
maintain the proper clearance from energized 
components .

 WARNING

Failure to properly configure a TripSaver II recloser in accordance with applicable codes and standards can 
result in misoperation or miscoordination, equipment damage, personnel injury, or death .

Settings should be determined and approved by qualified personnel who are familiar with the principles of 
selective coordination and system protection . S&C Electric Company is not responsible for the misoperation or 
miscoordination of a TripSaver II recloser resulting from improper configuration .

Make sure the TripSaver II recloser settings files are maintained in a secure manner by properly trained personnel .

 WARNING

The TripSaver II Cutout-Mounted Recloser MUST be de-energized and removed from the utility pole before 
attaching the “corded” power module (power module with ac adapter and extension cord) to the base of the 
TripSaver II recloser . The corded power module is ONLY intended to be used for setup and data collection when the 
TripSaver II recloser is de-energized and removed from the utility pole . (To provide power to a TripSaver II recloser 
while it is mounted to the pole, use the cordless power module, S&C catalog number 5954 .) Failure to remove the 
TripSaver II recloser from the utility pole before connecting the corded power module can cause arcing, 
burns, electric shock, and death .
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Shipping and Handling

A complete TripSaver II recloser configuration kit, which weighs about 4 lbs. (1.8 kg) and 
works with both 15-kV and 25-kV TripSaver II reclosers, consists of the following items 
stored in a carrying case:

Ac adapter

TripSaver II power module

USB transceiver

Carrying case

Power outlet plug adapters

Extension cord for ac adapter

Blank adhesive labels for user 
configuration parameters [in pairs: 

one white base and one transparent 
overlay; [90 mm × 94 mm (39/16 inches × 

311/16 inches)] . Label attaches to the left side 
of the lower TripSaver II recloser housing .

Antenna for USB Transceiver

Figure 1 . Components of the S&C TripSaver II recloser configuration kit .

Packing
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Examine the shipment for external evidence of damage as soon after receipt as possible, 
preferably before the carrier departs. Check the bill of lading to make sure the listed 
shipping packages are present.

If there is visible loss and/or damage:

1. Notify the delivering carrier immediately.

2. Ask for a carrier inspection.

3. Note condition of shipment on all copies of the delivery receipt.

4. File a claim with the carrier.

If concealed damage is discovered:

1. Notify the delivering carrier within 15 days of receipt of shipment.

2. Ask for a carrier inspection.

3. File a claim with the carrier.

Also, notify S&C Electric Company in all instances of loss and/or damage.

NOTICE

Handle the configuration kit with care . DO NOT drop the components or subject 
any of their parts to undue stress during use . Only remove components from the 
carrying case when they are ready to be used . After a TripSaver II recloser has been 
configured, always return components to the carrying case for protection .

In addition, DO NOT drop a TripSaver II recloser or subject any of its parts to undue 
stress during configuration or installation . Only remove a TripSaver II recloser from the 
carton when it is ready for configuration or installation . After a TripSaver II recloser has 
been configured, always return it to its carton until ready for installation .

Inspection

Handling
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Installing TripSaver® II Service Center Configuration Software

Installing TripSaver II Service Center Configuration (SCC) Software requires:

 ● A computer with Microsoft Windows 7 with Service Pack (SP) 1 with .NET framework 
version 4.7 or later or Microsoft Windows 10 and 11 with .NET framework version 4.7 
or later.

Note: If the .NET framework is missing, the software installer will automatically install 
.NET framework. Microsoft has discontinued Windows 7 support.

 ● Administrative privileges for software installation.

TripSaver II Service Center Configuration Software is available for download only to 
customers who have purchased the configuration kit. The latest release is posted on the 
S&C Automation Customer Support Portal at sandc.com/en/support/SC- customer- 
portal/. A username and password is required to log in to the portal. New S&C customers 
must complete the form in the lower section of the Web page, and a new username and 
password will be sent to them.

Customers who already have a password can click on the Log In to Secure Site 
button. This opens the log-in page. See Figure 2.

Figure 2 . The customer portal log-in page .

Enter the username and password and click on the Log In button to log in to 
the portal.

Go to the “TripSaver II Workspace” section and download the latest installer 
 SCC<version number>_Installer.exe file from the portal. 

Computer 
Requirements 

Downloading 
Software

http://sandc.com/en/support/SC-customer-portal/
http://sandc.com/en/support/SC-customer-portal/
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Use the following steps to install the software:

STEP 1 . Double-click on the downloaded installation file to self-extract and start the 
process. The name of the software and its version number will appear. Click on 
the Install button to proceed, or click on the Close button to quit the installa-
tion process. See Figure 3.

Figure 3 . Launching the software installer .

STEP 2 . After clicking on the Install button, wait for the installation to finish. The 
installer will automatically install the correct .NET framework onto the 
computer if .NET is missing. When .NET is successfully installed, the setup 
wizard for the S&C TripSaver II Service Center Configuration Software will open. 
See Figure 4. 

NOTICE

If a previous version of the TripSaver II Service Center Configuration 
Software version was installed on the computer, the installation process will 
remove it and install the latest version .

Figure 4 . The SCC installation setup wizard .

Software 
Installation
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STEP 3 . Click on the Next button to continue, or click on the Cancel button to quit the 
installation process. 

STEP 4 . The next dialog box to open allows the installer to select the installation folder. 
Click on the Change button to select a specific destination folder, or use the 
default folder shown. Click on the Next button to continue, or click on the 
Cancel button to quit the installation process. Click on the Back button to go 
back to the previous step. See Figure 5.

Figure 5 . The dialog box for selecting the destination folder .
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STEP 5 . When the installation folder has been selected, the Ready to Install dialog box 
opens. See Figure 6. Click on the Install button to begin the installation. Click 
on the Back button to review or change the settings, or click on the Cancel 
button to quit the installation process.

Figure 6 . The Ready to Install dialog box .

During the installation process, a status bar is shown. When the installation 
is complete, the screen shown in Figure 7 will be displayed. Click on the Finish 
button to exit the setup wizard.

Figure 7 . This dialog box indicates installation is complete .
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STEP 6 . When TripSaver II Service Center Configuration Software has been installed 
successfully, the Installation Successfully Completed dialog box opens. See 
Figure 8. Click on the Close button to exit the installer.

Figure 8 . The SCC Installation Successfully Completed dialog box .

The installation will create the following icon on the desktop and in the 
Windows Start menu. See Figure 9.

Figure 9 . The SCC software desktop icon .

To uninstall the TripSaver II Service Center Configuration Software from the 
computer, go to the Apps menu in the Windows Settings panel.
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Installing the USB Transceiver and Power Supply

A USB transceiver must be installed on the computer to communicate with a TripSaver II 
recloser. Note: Installing the configuration software and running the software in an offline 
mode does not require the presence of a USB transceiver. 

STEP 1 . Screw the threaded bottom of the antenna onto the threaded connector on the 
USB transceiver. See Figure 10. 

Threaded connector

Threaded-end of antenna

Figure 10 . Connecting the antenna to the USB transceiver .

STEP 2 . Insert the USB transceiver into any USB port on the computer. See Figure 11. 
The installation process is automatic.

Figure 11 . Inserting the USB transceiver into the computer .

Assembling and 
Installing the USB 
Transceiver
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A TripSaver II recloser can be powered by the power module to enable its communica-
tion capability. Complete the following steps before attempting to communicate with a 
TripSaver II recloser. 

Note: TripSaver II Service Center Configuration Software has an offline setting mode that 
allows TripSaver II recloser settings to be configured and saved without communicating 
with a recloser.

STEP 1 . Plug the connector of the ac adapter into the opening of the power module. See 
Figure 12.

Figure 12 . Inserting the power connector into the power module .

STEP 2 . Position the power module near the base of the TripSaver II recloser; the module 
will be held in place magnetically. See Figure 13.

Figure 13 . Attaching the power module to the TripSaver II recloser .

Assembling the 
Power Supply 
and Powering 
the TripSaver II 
Recloser
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STEP 3 . Install the proper power outlet plug adapter onto the ac adapter. See Figure 14.

Figure 14 . Installing the outlet plug adapter .

STEP 4 . Plug the ac adapter into a wall outlet. See Figure 15.

Figure 15 . Plugging the ac adapter into a live outlet .

To verify the TripSaver II recloser is powered up, rotate the MODE-SELECTOR lever 
and observe the LCD screen. If the LCD screen begins to scroll, it indicates the recloser 
has been successfully powered.
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A Transceiver ID unique to each TripSaver II recloser is needed to establish communica-
tions between the computer and the recloser. The ID consists of a 32-digit character string 
in the format of: 

“0019C900 .00020000 ._ _ _ _ _ _ _ _  . _ _ _ _ _ _ _ _”

The Transceiver ID for the TripSaver II recloser can be obtained through the following 
methods:

 ● Method 1: The Transceiver ID is embedded in the QR code laser-etched onto the 
lower housing of each TripSaver II recloser. See Figure 16. Download a free QR 
scanner app to a smart phone and scan the QR code to obtain the Transceiver ID.

QR code

Figure 16 . The Transceiver ID QR code .

 ● Method 2: Rotate the MODE-SELECTOR lever to initiate the Display screens after 
the TripSaver II recloser is powered up. The LCD screen will begin to scroll. The first 
screen displayed contains the Transceiver ID. See Figure 17. 

Note: This screen does not appear when communication is disabled or when no screens 
are added to the Display screen sequence.

Figure 17 . The Transceiver ID shown on the first LCD scrolling screen .

Obtaining the 
Transceiver ID



Installing the USB Transceiver and Power Supply

.  S&C Instruction Sheet 461-504  17

 ● Method 3: The Transceiver ID is also printed on the back of the yellow “DO NOT 
DROP—HANDLE WITH CARE” tag attached to each TripSaver II recloser when it 
leaves S&C Electric Company. See Figure 18.

Figure 18 . The Transceiver ID label .
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Using TripSaver II Service Center Configuration Software

Click on the SCC icon on the desktop or in the Start menu to launch the TripSaver II 
Service Center Configuration Software. See Figure 9 on page 12.

 The warning message shown in Figure 19 is displayed after the software is launched:

The configuration process starts after clicking on the green I have read and under-
stand the above Warning button.

Figure 19 . The SCC software Warning message .

Apply. Overwrite old settings in a TripSaver II recloser with new settings.

Buffer. An area of memory in the software holding temporary settings information.

Revert. Reset the edit buffer to its original state. The definition of the “original state” is 
explained in the “Revert” section of this instruction sheet on page 35. 

Setpoints. Setpoints are user-changeable settings entered into the control to configure a 
TripSaver II recloser. Setpoints are displayed as check boxes, light-blue text, or selection 
menus. Setpoints can be saved locally to a setpoint file with the extension .xspt.

Snapshot. A snapshot file captures all data from a TripSaver II recloser at a specific 
instant. The setpoints part of the snapshot can be saved locally to a setpoint file. Snapshot 
files have the extension .xdss.

Validate. Check settings against validation rules that define a valid configuration.

Note: For SCC software v1.8, v1.9, v2.0, and v2.1, the validation feature will NOT prevent 
the user from applying settings that are out of range for the ratings of the TripSaver II 
recloser. Instead, a warning will be displayed informing the user that settings are out of 
range. The user will have the opportunity to either accept an out of range setting, or adjust 
it before applying. Accepting an out of range setting will then be entered into the factory 
service log.

Launching the 
Software

Reading and 
Understanding the 
Warning Message

Terminology
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TripSaver II Service Center Configuration Software is used to communicate with and 
configure TripSaver II Cutout-Mounted Reclosers. The user interface is organized in the 
following way:

Menu Bar and Quick Access Toolbar
At the top of the user interface is a menu bar that has a number of commands. Below the 
menu bar is a quick access toolbar with the most frequently used commands found in the 
menu bar. See Figure 20.

Menu bar 
Quick access toolbar 

Figure 20 . The menu bar and quick access toolbar found on all screens .

Menu Tree
On the left side of the user interface is a menu tree that contains the names of available 
screens. Click on the menu tree items to navigate through screens. Active screens are high-
lighted, and the rest remain gray. See Figure 21.

Figure 21 . The menu tree on the left side of every screen .

Overview
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Main Body
To the right of the menu tree is the main body of the user interface, where configuration 
and other tasks are performed. See Figure 22.

Figure 22 . The main body of the screen is to the right of the menu tree .

Additional Information Bar
At the bottom of the screen is an information bar that contains additional recloser-related 
information. See Figure 23.

Figure 23 . The information bar at the bottom of the screen .
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Standalone Mode
TripSaver II Service Center Configuration Software has two operating modes: Standalone 
(offline) and Connected (online). The software automatically enters the Standalone 
mode after the software is launched. It starts with S&C default configuration settings. 

Users can define their own default settings that the software uses in Standalone 
mode by selecting the Tools>Options>Standalone option. In Standalone mode, the 
settings can be configured without being connected to a recloser, saved to a setpoint file 
for later use, and loaded into a previously saved snapshot file for analysis. Six settings 
screens are available under this mode. They are: 1) TCC Curve Settings, 2) NR Curve 
Settings, 3) Sectionalizing Settings, 4) LCD Screen Settings, 5) Communications 
Settings, and 6) Local Manual Open. See Figure 24. 

Note: Validation in Standalone mode will validate for a TripSaver II recloser rated 
100 amperes continuous. Validation in Connected mode will validate settings based on the 
actual continuous current setting of the recloser: 40 A, 100 A, or 200 A.

Figure 24 . The Standalone mode menu tree items .
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Connected Mode
The software enters the Connected (online) mode when a communications connection is 
established with a TripSaver II recloser. When connected, the setpoints from the recloser 
will be placed into the edit buffer, overwriting all previous settings in the buffer. When the 
present settings in the buffer have not been saved, a prompt to save the settings will open 
before connecting to the recloser.

NOTICE

If serial number information, catalog number information, or programmed settings are 
missing or the screen shows incorrect continuous current rating . Please refer to the 
“Restoring Profile If Lost During a Firmware Update” section on page 122 .

Under Connected mode, users can view existing settings, status information, and 
event logs of the TripSaver II recloser, apply new settings to the control, download a 
snapshot file, or perform functional tests. Three additional screens are available under 
this mode. They are: 1) Status, 2) Event Logs, and 3) Functional Test. See Figure 25. And 
as follows, the 4) R‑NR Functions screen, 5) Gateway Drop Open screen, and 6) DNP 
Remote Drop Open screen, will open if the TripSaver II recloser has the Extended Open 
Interval option (“-O”). These screens are also available when a snapshot file is open.

The software also allows viewing the data captured in a previously saved snapshot file.

Figure 25 . The Connected mode menu tree items .
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At the top of the user interface is a menu bar that contains a number of commands that are 
described in this section. Below the menu bar is a quick access toolbar that contains the 
most frequently used commands found in the menu bar. See Figure 26. 

Figure 26 . The quick access toolbar .

Each Menu Bar function is described in the following sections: “File Menu,” “Connec-
tion Menu,” “Data Menu,” “Tools Menu,” and “Help Menu.”

Menu Bar 
Functions
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File Menu

When a snapshot is saved, the configuration software can open it later and the data can 
be viewed offline. A snapshot file can be opened under the Standalone (offline) or 
Connected (online) mode or when another snapshot is already open. Users can also 
edit the settings part of a snapshot file and then save the modified settings to a setpoints 
file. A previously saved snapshot can be opened by selecting the File>Open Snapshot 
option from the Main menu or by clicking the Open Snapshot icon  in the quick access 
toolbar. 

If the present setpoint changes were not saved in the edit buffer, an Operation: Open 
Snapshot dialog box will open asking that it be saved. Click on the Discard button to open 
the snapshot without saving settings, click on the Save button to save setpoints first, or 
click on the Cancel button to quit the Open Snapshot process. See Figure 27.

Figure 27 . The Operation: Open Snapshot dialog box for saving changes before the Open 
Snapshot process .

When attempting to open a snapshot before finishing any TCC curve-selection process, 
the dialog box shown in Figure 28 will open. Click on the Cancel button to complete TCC 
curve selection and then try again. Click on the Discard button to open a snapshot without 
saving the modified settings on the screen. 

Figure 28 . The Operation: Open Snapshot dialog box for completing TCC curve selection 
before the Open Snapshot process .

The File-open dialog box opens to allow browsing for and selecting a snapshot file 
to be opened. When the snapshot is opened successfully, the message shown in Figure 29 
will open.

Figure 29 . The snapshot successfully opened .

Open Snapshot
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When a snapshot is opened, data captured from the TripSaver II recloser can 
be viewed or modified, and the setpoints in the snapshot file can be saved in a new 
setpoints file. 

When opening a snapshot file under the Connected (online) mode, the recloser will 
be disconnected automatically, and no data will be applied to the connected TripSaver II 
recloser. If no setpoint changes have been saved in the edit buffer, a prompt will open 
asking the user to do so. The TripSaver II recloser can be reconnected after a snapshot file 
is opened. See the “Connect to Device” section on page 29.

The snapshot saved always has the same version number as the firmware version 
of the TripSaver II recloser from which the snapshot file was generated. Snapshots with 
any earlier version numbers can all be opened and viewed using the latest version of the 
service center configuration software.

A snapshot can be closed by selecting the File>Close Snapshot option from the Main 
menu or by clicking on the Close Snapshot icon  in the quick access toolbar, or simply 
by exiting the software. If attempting to close a snapshot without first saving any modified 
settings in the edit buffer, the dialog box shown in Figure 30 will open.

Figure 30 . The Operation: Close Snapshot dialog box for saving changes before a Close 
Snapshot command .

Click on the Discard button to close a snapshot without saving settings. Click on the 
Save button to save setpoints first, or click on the Cancel button.

The Close Snapshot button is only available when a snapshot file is open. When a 
snapshot is closed, the software goes to the Standalone mode.

If an attempt is made to close a snapshot before finishing a TCC curve-selection 
process, the dialog box shown in Figure 31 will open. Click on the Cancel button to 
continue making TCC curve selection changes. Click on the Discard button to close 
snapshot without saving the modified settings. The Save button is unavailable in this case.

Figure 31 . The Operation: Close Snapshot dialog box for completing TCC curve selection 
before a Close Snapshot operation .

Close Snapshot
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This feature is only available when connected to and communicating with a TripSaver II 
recloser. To save a snapshot, select the File>Save Snapshot option from the Main menu 
or click on the Save Snapshot icon  in the quick access toolbar. A File Selection dialog 
box will open, allowing selection of a name and location where the file is to be saved. 

This process can take several minutes. During the saving process, the progress bar 
shown in Figure 32 will be displayed.

Figure 32 . The Save snapshot progress bar .

Click on the Cancel button to cancel the Save Snapshot operation. If the snapshot is 
saved successfully, the message shown in Figure 33 appears.

Figure 33 . The dialog box noting Snapshot successfully saved .

Snapshot files have the .xdss extension.

NOTICE

DO NOT unplug the USB transceiver or power down the recloser until the Save 
Snapshot process is completed .

The snapshot saved always has the same version number as the firmware version of 
the TripSaver II recloser where the snapshot file is generated.

Save Snapshot
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Previously saved setpoints, either from a setpoints file (.xspt) or from a saved snapshot 
file (.xdss), can be loaded into the edit buffer file by selecting the File>Load Setpoints 
option from the Main menu or by clicking the Load Setpoints icon  in the quick access 
toolbar. When the setpoint changes have not been saved or applied in the edit buffer, an 
Operation: Load Setpoints dialog box will open. See Figure 34.

Note: When loading a setpoints file made in service center configuration software version 
1.8 (or earlier) to a TripSaver II recloser using a later firmware version, the older setpoints 
file will configure the TripSaver II recloser with the version 1.8 (or earlier) settings by 
default. If any of the new functions available in the most recent version of the software are 
required, they must be manually set after the older setpoints file is loaded.

Figure 34 . The Operation: Load Setpoints  dialog box for saving changes before a Load 
Setpoints operation .

Click on the Discard button to load setpoints without saving settings. Click on the 
Save button to save setpoints in the edit buffer first. Or click on the Cancel button to quit 
the Load Setpoints process. 

The Load Setpoints dialog box opens to allow browsing and selecting a setpoint file or 
a snapshot file to load. When the setpoints are loaded successfully, the message shown in 
Figure 35 will open.

Note: Loaded setpoint values will not take effect in the recloser until they have been 
applied.

Figure 35 . The dialog box noting setpoints were loaded successfully .

Load Setpoints
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Setpoints can be saved while in Standalone (offline) mode, Connected (online) mode, 
or when a snapshot file is opened by selecting the File>Save Setpoints option from 
the Main menu or by clicking the Save Setpoints icon  in the quick access toolbar. A 
file-selection dialog box will open to allow selecting a name and location where the file 
will be saved. When the setpoints are saved successfully, the message shown in Figure 36 
will open.

Figure 36 . The dialog box noting setpoints successfully saved .

A complete or partially completed set of setpoints can be saved. However, if having 
started but not finished the process of selecting a TCC curve, setpoints cannot be saved, 
and the Save Setpoints button is grayed out until the curve-selection process is complete. 
The Save Setpoints button is grayed out when it is not available.

Setpoint files have the .xspt extension. When connected to a TripSaver II recloser or 
when a Snapshot file is open, the setpoint files saved only contain setting fields available to 
the firmware version of the TripSaver II recloser or snapshot file from which the setpoint 
files have been generated.

To exit the TripSaver II Service Center Configuration Software, select the File>Exit option 
or click on the “×” icon  in the upper right corner of the main screen. If the setpoint 
changes have not been saved or applied in the edit buffer, a prompt to do so will open. 
Click on the Discard button to exit the software without saving settings. Click on the Save 
button to save setpoints first, or click on the Cancel button to quit the exit process. See 
Figure 37.

Figure 37 . The Operation Exit dialog box for saving changes before exiting .

Save Setpoints

Exit
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Connection Menu

To connect to a TripSaver II recloser, select the Connection>Connect to Device option 
from the Main menu or click on the Connect to Device icon  in the quick access 
toolbar. Make sure the USB transceiver is already plugged in to the computer. 

If attempting to connect without saving the modified settings first, the dialog box in 
Figure 37 on page 28 will open. Click on the Discard button to connect without saving 
settings, click on the Save button to save setpoints first, or click on the Cancel button to 
quit the process. 

If attempting to connect before finishing any TCC curve selection process, the dialog 
box shown in Figure 38 will open. Click on the Cancel button to complete TCC curve 
selection and then try again. Click on the Discard button to connect without saving the 
settings. The Save button is unavailable in this case.

Figure 38 . The Connect dialog box for completing TCC curve selection before connecting .

Next, a Transceiver ID Request dialog box will open. Enter the Transceiver ID of 
the TripSaver II recloser to be connected, and click on the OK button to connect. If the 
TripSaver II recloser is furnished with firmware version 1.8 or later, the Auto Detect 
button can be used to auto-detect the Transceiver ID. If the Auto Detect button is 
used with a recloser with firmware version 1.7 or previous, the Auto-Detect feature 
will display a pop up stating that the Auto-Detect feature will not work for previous 
versions of the firmware. The transceiver ID is unique to each TripSaver II recloser, and it 
consists of a 32-digit character string in the format of “0019C900.00020000. _ _ _ _ _ _ _ _ 
. _ _ _ _ _ _ _ _.” The first 16 digits of the ID are pre-typed. Only the last 16 digits must be 
entered. See Figure 39. Up to 16 previously typed valid IDs are saved under the drop-down 
menu. When the drop-down menu is full, the oldest ID will be replaced by a new ID.

Figure 39 . The Transceiver ID Request dialog box .

NOTICE

USB transceivers with firmware version 1 .6 can connect to TripSaver II reclosers 
with firmware version 1 .9 or lower using service center configuration software v2 .1 . 
To connect to TripSaver II reclosers with firmware version 2 .0, USB transceivers with 
firmware version 1 .6 must be upgraded to firmware version 2 .0 .

USB transceivers with firmware version 2 .0 can connect to all TripSaver II firmware 
versions using the latest version of the service center configuration software . See the 
“USB Transceiver Firmware Update” section on page 43 .

Connect to Device
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During the connection process, a progress bar is displayed. See Figure 40. Wait about 
10 seconds for the connection process to finish, or click on the Cancel button to cancel 
the connection process.

Figure 40 . The progress bar during the Connection process .

The message shown in Figure 41 will open if the format of the transceiver ID entered 
is invalid, e.g. fewer than the required 32 digits. Click on the OK button and then click on 
the Connect to Device button to restart the process.

Figure 41 . The Invalid Transceiver ID message .

The following screen will open if a USB Transceiver is not present, the contacts 
between the USB port on the computer and the transceiver are not reliable, or the trans-
ceiver serial port is being used by another program. Correct the problem and click on the 
Retry button. Click on the Cancel button to quit the connection process. See Figure 42.

Figure 42 . The “Unable to detect USB transceiver” prompt message .

To connect to TripSaver II reclosers with firmware version 1.9 or earlier, the USB 
transceiver MUST have firmware version 1.6 or 2.0 for a successful connection. Otherwise, 
the message shown in Figure 42 will appear. The combination of USB transceiver version 
1.6 or 2.0 and the latest version of the service center configuration software will be back-
ward-compatible with all TripSaver II recloser firmware versions.
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To connect successfully with TripSaver II reclosers with firmware version 2.0, a USB 
transceiver with firmware version 2.0 is required. Either update a USB transceiver with 
firmware version 1.6 to 2.0 using the procedure detailed in the “USB Transceiver Firmware 
Update” section on page 43, or use the new USB transceiver part number FDA-1868R2.

The connection may not succeed if the TripSaver II recloser is not powered up or the 
32-bit transceiver ID is incorrect. If the connection is not successful, the message shown in 
Figure 43 will open. Click on the Retry button to restart the connection process, or click 
on the Cancel button to quit the process.

Figure 43 . The Connection Timeout dialog box .

When the recloser is connected, the signal strength indication is displayed at the lower 
left corner. See Figure 44. The Status screen is then opened and populated with data from 
the connected recloser. Navigation is now possible to other screens.

Figure 44 . The signal strength indicator .

Terminate the connection with a TripSaver II recloser by selecting the Connection> 
Disconnect menu item or by clicking on the Disconnect button  in the quick access 
toolbar. The TripSaver II Service Center Configuration Software will terminate the session 
and switch to the Standalone mode. The recloser also can be disconnected by just exiting 
the software. If any setpoint changes have not been saved or applied in the edit buffer, a 
dialog box will open asking the user to do so. 

Disconnect
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Data Menu

Settings are temporarily stored in the edit buffer on the computer and are not active until 
they have been applied to the TripSaver II recloser. The following commands manage 
settings between the edit buffer and the active-settings area of the control.

 

The Validate command checks settings against validation rules that define a valid config-
uration. This function is available for the Standalone (offline) mode, the Connected 
(online) mode, and when a snapshot file is open. To validate settings in the edit buffer 
without applying them, select the Data>Validate option from the Main menu or click the 
Validate icon  in the quick access toolbar.

If the validation procedure detects an error, a red error message explaining the error 
will be displayed in the Validation Results panel at the bottom of the main screen area. See 
Figure 45.

Figure 45 . The Validation Results message .

Validate
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To view a setpoint field that failed the validation rules, expand the description by 
double-clicking on the red error message and then single-clicking on the name of the field 
in black color in the Validation Results panel, as indicated in Figure 46. The border of the 
erroneous field will be highlighted in red. 

Note: When validating settings in Standalone mode, the service center configuration 
software will provide accurate validation for settings for a 100-A continuous TripSaver II 
recloser. When validating settings in Connected mode, the service center configuration 
software will detect the actual continuous current rating of the TripSaver II recloser 
(40 A, 100 A, or 200 A) and validate settings accordingly. If a setpoint value entered is out 
of range, the border of that edit field will be highlighted in red automatically. Any invalid 
value will be erased from the edit field when navigating to another settings screen.

Figure 46 . The border of the erroneous field, highlighted in red .

For validation under the Connected (online) mode, various error messages are also 
generated if mandatory setpoint fields are not filled in. For validation in the Standalone 
mode, the software only validates settings that have already been entered. 

When the validation is successful, the Validation Results panel will display a message 
in green at the bottom of the main screen area after the Validate button is clicked. See 
Figure 47.

Figure 47 . The message showing successful validation .
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For settings that can be applied but need special attention, the Validation Results 
panel will display a warning message in black. See Figure 48.

Figure 48 . The Validation Warnings message .

Clicking on the Close button closes the Validation Results panel. Click on the 
Validate button again to bring back the Validation Results panel. Click on the Validate 
button at any time to re-validate and display remaining errors, if any.

The Apply function is only available when connected to and communicating with a 
TripSaver II recloser. To apply newly configured settings to the TripSaver II recloser, select 
the Data>Apply option from the Main menu or click on the Apply button  in the quick 
access toolbar. The software will validate all of the settings first before applying them to 
the recloser. Previous settings in the TripSaver II recloser will be overwritten and cannot 
be restored. The warning shown in Figure 49 will be displayed before the process starts. 
Save previous settings to a setpoint file or to a snapshot file before proceeding. 

Figure 49 . The overwrite warning before an Apply operation .

NOTICE

DO NOT unplug the USB transceiver or power down the recloser until the Apply 
process is completed .

The procedure for applying settings has multiple automatic steps and can take a few 
minutes. The process cannot be canceled when the process passes the second of those 
steps. Do not unplug the USB transceiver or power down the recloser until the process is 
completed. The message shown in Figure 50 will be displayed after settings are success-
fully applied.

Apply
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Figure 50 . The Apply dialog box showing the settings applied successfully .

 To reset the edit buffer to its original state, select the Data>Revert option from the Main 
menu or click on the Revert button  in the toolbar. The “original state” is defined as:

 ● For Standalone (offline) mode—Default settings the Standalone mode always starts 
with each time the software is launched

 ● For Connected (online) mode—Active settings presently residing in the connected 
TripSaver II recloser

 ● When a snapshot file is open—Settings saved in the snapshot file 

Note 1: Loading a setpoint file does not create a new original state. 

Note 2: The Revert button does not undo a configuration step. It is not an “undo” button. 
It also will not undo an Apply command.

Revert
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Tools Menu

 Under the Options feature, preferences can be changed for PC-to-TripSaver II commu-
nication-related logging, several communication parameters can be set, and the default 
settings the software uses under the Standalone (offline) mode can be changed.

The two logging-related features are mainly intended for engineering-debugging use in 
case the communications encounter any unexpected errors. S&C recommends customers 
use default settings unless instructed to do otherwise by S&C technical support.

Note: Customer privacy is important to us. No logging information is sent back to S&C or 
any third-party company over the Internet. All logging information is stored locally on the 
computer. 

Logging
Enable Log. Select the check box to enable communication-related logging. Deselect the 
check box to disable communication-related logging. When deselected, all fields under the 
Logging tab will be grayed out. Default is “Enabled.”

The interaction between the PC and the USB transceiver is also included in the log.

Log File Directory. This directory displays where the communication-related logging files 
will be saved. Type a full directory path into the field, or use the Browse button on the 
right to select a desired directory. This field is grayed out when the Default check box (for 
the Log File Directory) is selected.

Note: Do not select a directory on a network drive.

Default check box. Select the check box to use the default log file directory. Uncheck 
the box to use the directory selected previously. The default log file directory is C:\Users\
(yourcomputername)\Documents\S&C Electric\SCC. When the default check box is 
selected, the Log File Directory field will be grayed out and display the default log file 
directory. The default for the Default check box is the Enabled setting.

Level. Three levels of logging details are available for selection:

 ● Basic. This level logs sufficient error/warning information for initial analysis. It is the 
default logging level.

 ● Medium. This level logs all traffic (e.g. packets exchanged), and is to be used by 
trained S&C support personnel. Medium is the default logging level at software 
installation.

 ● Detailed. This level traces the code execution in addition to those being logged at the 
Medium level and is to be used only by S&C Software Developers to look for diffi-
cult bugs.

Maximum File Size (kB). Specify the maximum size, in kilobytes, allowed for each log 
file. (Unlimited: 0; default: 10000)

Number of Old Log Files. Specify the maximum number of old log files to keep in the 
selected directory. (Unlimited: 0; default: 500)

Restore Defaults. Click on this button to change settings under the present tab to their 
default values. This button is grayed out when all settings under the present tab are the 
same as their default values.

Options



Tools Menu

.  S&C Instruction Sheet 461-504  37

Apply. Click on this button to apply settings and exit the option box. New settings will 
take effect after clicking on the Apply button. This button is grayed out when there are no 
changes made under all three Options tabs or when an incorrect value has been entered.

Cancel. Click on this button to discard changes and exit the option box.

Communication
Timeout, ms. Specify the duration (in milliseconds) the software waits for a response 
from a connected TripSaver II recloser before it retries. The default is 500.

Retries. Specify the number of additional times the software sends a communication 
request to a connected TripSaver II recloser. The default is 20.

Intersend Delay, ms. Specify the duration (in milliseconds) the software waits before it 
sends the next communication request to a TripSaver II recloser. The default is 20.

Note: These settings are optimally set and should only be changed when directed by an 
S&C technician.

Standalone
Use the Customer Settings check box. Select this check box to use a customer 
setpoints file or the setpoints part of a saved snapshot file as the default settings the 
software uses under the Standalone (offline) mode. Deselect the check box to use S&C 
factory default. When deselected, the File Name path field under the check box will be 
grayed out.

File Name path. This field displays the path of the file used for the customer default 
settings under the Standalone (offline) mode. Type a full directory path into the field, or 
use the Browse button on the right to select a desired file. This field is grayed out when 
the S&C factory default is used (Use Customer Settings check box deselected).

A report of the configuration settings and the Event log displayed in the TripSaver II 
Service Center Configuration Software can be printed by selecting the Tools>Create 

Report option or by clicking on the Create Report button  in the quick access toolbar. 
This feature is available in both the Standalone (offline) mode, Connected (online) 
mode, or when a snapshot file is open.

Note: Customer privacy is important to us. No logging information is sent back to S&C 
Electric Company or any third-party company over the Internet during this process. The 
report generated will reside locally on the computer.

Report format. Select the preferred format for the report created, either in html or csv.

What to report. Use the check box to select the contents to be reported, either Settings, 
or Event Log, or both. The Event Log check box is grayed out in the Standalone 
(offline) mode.

Save to file. This displays the file to which the report created will be saved. Type a full 
file path including the folder and desired name of the file into the field, or use the Browse 
button on the right to select a desired directory, and then name the file. The report will be 
created on the desktop if a path is not specified.

Note: Do not select a directory on a network drive.

Create Report
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Open after save. Select the check box to open the file automatically after it is saved.

Report. Click on this button to generate a report. This button is grayed out when none of 
the check boxes in the What to report field are selected or when the Save to file path is 
left empty.

Cancel. Click on this button to exit the Create Report process.

When a report file is created, an information message similar to that shown in 
Figure 51 will be displayed.

Figure 51 . The dialog box showing a report successfully generated and its file location .

NOTICE

The TripSaver II recloser must be removed from the utility pole and placed near the 
USB Transceiver before performing a firmware update . 

NOTICE

DO NOT perform a firmware update using the cordless power module . Use the corded 
power module attached to an appropriate ac power source .

TripSaver II Service Center Configuration Software 2.1 (this release) is backward-compat-
ible with all TripSaver II recloser firmware versions: 2.0, 1.9, 1.8, 1.7, 1.6, 1.5, 1.3, and 1.0. It 
can update TripSaver II recloser firmware versions 1.5, 1.6, 1.7, and 1.8 to 1.9, and firmware 
version 1.0 to 1.3. 

Because of changes in TripSaver II recloser hardware, service center configuration 
software version 2.1 is unable to update TripSaver II reclosers loaded with firmware 
versions 1.3 to the latest firmware version 2.0. A TripSaver II recloser with firmware 
version 1.3 can no longer be updated. Also, because of hardware changes, TripSaver II 
reclosers loaded with firmware versions 1.8, 1.7, 1.6, and 1.5 can only be upgraded to 
firmware version 1.9. A TripSaver II recloser with firmware version 1.9 cannot be updated 
to 2.0. 

Firmware Update
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To update the firmware in the TripSaver II recloser, complete the following steps:

STEP 1 . Connect to the TripSaver II recloser with a computer loaded with service center 
configuration software v2.1, plug a USB transceiver into the USB port of the 
computer and attach the ac power module to the TripSaver II recloser.

STEP 2 . Make a note of the serial number, starting with “TCMR,” of the TripSaver II 
recloser to be updated. See Figure 52. This number is also etched on the body of 
the TripSaver II recloser.

Figure 52 . The TripSaver II recloser serial number and Signal Strength indicator locations .
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STEP 3 . Check that the Signal Strength indicator on the left side of the Additional Infor-
mation Bar is green. See Figure 52 on page 39. See the “Additional Information 
Bar” section on page 20 for more information on the Signal Strength indi-
cator. Then, optimize the signal strength between the TripSaver II recloser and 
USB transceiver, as described in the “Optimizing Signal Strength” section on 
page 113. If in an area with strong signal interference, or if the Signal Strength 
indicator is yellow or red, do not try to update the TripSaver II recloser’s 
firmware.

NOTICE

DO NOT unplug the USB transceiver or power down the recloser until the 
Firmware Update process is completed . 

When the service center configuration software is communicating with a 
TripSaver II recloser via the communications gateway, the firmware update 
function will be disabled . Firmware updates can only be done using the 
USB transceiver from the service center configuration kit .

STEP 4 . Select the Tools>Firmware Update option from the Main menu, or click on 
the Firmware Update icon in the quick access toolbar. If the firmware is out of 
date, a dialog box will appear. See Figure 53. 

Figure 53 . The firmware update Warning dialog box .

STEP 5 . Select the Perform firmware update option, and then click on the OK button.
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STEP 6 . A second dialog box will open. See Figure 54. Agree with the terms and condi-
tions by selecting the appropriate option. Then, click on the OK button. If 
instead wanting to abort the firmware update, select the Disconnect from the 
TripSaver II and work offline without performing firmware update option 
and click on the OK button.

Figure 54 . The firmware update Terms and Conditions dialog box .

The update process can take several minutes and automatically completes 
the following:

 ● Saves a snapshot file before updating the firmware (See Figure 55.)

 ● Updates the firmware (See Figure 56.)

 ● Applies the settings and historical logs from the saved snapshot file back 
to the TripSaver II recloser (If new features are available after the update, 
default settings for those features will be loaded to the TripSaver II 
recloser.)

 ● Opens the software screens that support the newly loaded firmware

Figure 55 . The firmware update saving a snapshot file before updating the firmware .

Figure 56 . The firmware update progress bar .
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STEP 7 . A “Success” message will appear upon successful completion of the firmware 
update. After the update, check the Status screen to make sure the latest 
firmware has been applied correctly. See Figure 57.

Figure 57 . Status screen to check the latest firmware version .
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Information on the Restore Profile menu item can be found in “Restoring Profile If Lost 
During a Firmware Update” section on page 122.

USB transceivers with firmware version 1.6 can connect TripSaver II reclosers with 
firmware version 1.9 or lower using service center configuration software v2.1. For 
TripSaver II reclosers with firmware version 2.0, USB transceivers with firmware version 
1.6 must be upgraded to firmware version 2.0.

USB transceivers with firmware version 2.0 can connect to all TripSaver II firmware 
versions using service center configuration software v2.1.

To upgrade the USB transceiver firmware, complete the following steps:

STEP 1 . Plug a USB transceiver with firmware version 1.6 into the USB port of the 
computer. Do not connect to a TripSaver II recloser. Keep the service center 
configuration software in Standalone mode.

NOTICE

DO NOT unplug the USB transceiver until the USB Transceiver Firmware 
Update process is completed . 

STEP 2 . Select the Tools>USB Transceiver Firmware Update option from the Main 
menu. See Figure 58.  

Figure 58 . USB Transceiver Firmware Update menu item under the Tools menu .

Restore Profile

USB Transceiver 
Firmware Update
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STEP 3 . If the firmware can be updated, the following  selection menu will appear. See 
Figure 59.  (If the firmware is up to date, a dialog box will appear. See Figure 62.)

Figure 59 . The Firmware in USB Transceiver is Outdated selection menu .

Click on the Perform Firmware Update radio button. A progress bar will 
appear showing the USB transceiver firmware update progress. See Figure 60.

Figure 60 . The USB transceiver firmware update progress bar .

STEP 4 . When the update is complete, a dialog box will appear displaying a success 
message. Click on the OK button. See Figure 61.

Figure 61 . The USB transceiver firmware update success message .

Note: If the USB transceiver is up to date, the dialog box in Figure 62 will appear.

Figure 62 . The Cannot update USB Transceiver Firmware dialog box .
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Note: If the service center configuration software is in Connected mode (communi-
cating with a TripSaver II recloser) the dialog box shown in Figure 63 will appear. The 
USB Transceiver Firmware Update procedure can only be completed in Standalone 
(offline) mode.

Figure 63 . The Cannot update USB Transceiver Firmware dialog box when service center 
configuration software is in Connected mode .

Note: If the service center configuration software is unable to detect the USB trans-
ceiver, unplug it and plug it back in. If it’s still not working, try a different USB port on the 
computer. See Figure 64.

Figure 64 . The USB Transceiver cannot be detected dialog box .

The Clear “Service Now” menu item will only appear when a Clear Service Now proce-
dure is being performed. Information on the Clear “Service Now” menu item can be 
found in “Clearing the Service Now LCD Screen” section on page 115.

Selecting the Help>Help S&C TripSaver II Service Center Configuration Software 
option provides a copy of this instruction sheet.

Note: The latest version of Instruction Sheet 461-504 will always be available from 
sandc.com.

Clear “Service 
Now”

Help on S&C 
TripSaver II 
Service Center 
Configuration 
Software

http://sandc.com
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Help Menu

Selecting the Help>About S&C TripSaver II Service Center Configuration Software 
option displays the copyright information and revision information of the TripSaver II 
Service Center Configuration Software, its database, and firmware included. 

To magnify the main body of the screen, click on the Zoom In button. See Figure 65. To 
zoom out, click on the Zoom Out button. See Figure 66.

Figure 65 . Magnifying the screen size .

Figure 66 . Reducing the screen size .

About S&C 
TripSaver II 
Service Center 
Configuration 
Software

Zoom In/Out
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Additional Information Bar

At the bottom of the user interface is an information bar containing four pieces of addi-
tional recloser-related information. See Figure 67. 

Signal Strength Indicator
Main Caps Charge

TripSaver II Serial Number

Figure 67 . The Additional Information bar at the bottom of the screen .

Signal Strength. The Signal Strength indicator provides information on the quality of 
the communication. It uses four different icons to indicate different signal strength levels: 

 ● When there is no active communication: 

 ● When the signal quality is poor (red): 

 ● When the signal quality is acceptable (yellow): 

 ● When the signal quality is good (green): 

A numerical representation of the signal strength is also provided in units of dBm. The 
greater the value (e.g. -69 is greater than -87), the better the signal strength.

Main Caps Charge. This indicates the state of charge of the main power supply capaci-
tors inside the TripSaver II recloser. 

The bar stays mostly unfilled during the configuration process, indicating only a small 
amount of charge is needed by the control for configuration use. The blue color indicator 
will start to fill the empty space as the main capacitors’ charge increases, e.g. during func-
tional testing. 

The Main Caps Charge indicator is available for the Connected (online) mode or 
when a snapshot file is open.

Connected To (or Snapshot From). “Connected To” is displayed for the Connected 
(online) mode. It indicates the serial number of the TripSaver II recloser presently 
connected.

“Snapshot From” is displayed when a snapshot file is open. It indicates the serial 
number of the TripSaver II recloser from which the snapshot being viewed was saved. See 
Figure 68.

Figure 68 . The “Snapshot From” serial number .
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Transceiver ID. This indicates the transceiver ID of the TripSaver II recloser presently 
connected. It is only available for the Connected (online) mode.

Battery State of Charge. This indicates the state of charge of the rechargeable battery 
inside a TripSaver II recloser furnished with the Extended Open Interval feature (“-O” 
option). See Figure 69.

Figure 69 . The internal battery state of charge indicator .

The bar will be filled completely blue if the state of charge is full, and the length will 
recede as the state of charge drops.
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Entering Data

Setpoints
Setpoints are user-changeable settings entered into the control to configure a TripSaver II 
recloser. Setpoints are displayed as check boxes, data-entry fields, and selection menus. 
The font color of all setpoints is light blue. Complete a setpoint configuration by clicking 
anywhere outside its editable field. If a setpoint field is grayed out, it is presently 
unavailable.

Check box: When the mouse cursor is located over a check box, the background color of 
the check box will change to light blue. Select a check box to enable the feature; deselect 
a check box to disable the feature. Note: Deselecting a check box will erase all settings 
under that feature in the edit buffer.

Data-entry field: When the mouse cursor is located over a data-entry field, the border of 
the field will change to light blue. Click into the data-entry field to enter the setting. 

Selection menu: When the mouse cursor is located over a selection menu, the back-
ground color of the selection menu will change to light blue. Click on the menu to expand 
the list of available items. Click on an item in the list to finish the selection. The back-
ground color of the selection menu will change to dark blue, and the font color will change 
to white. Click anywhere outside the menu to complete the configuration.

Setpoints can be saved locally to a setpoint file with the extension .xspt. A previously 
saved setpoint file can be loaded into the edit buffer to make changes or to apply the 
settings to a recloser later. Save Setpoints and Load Setpoints functions are available in 
both the Standalone (offline) and Connected (online) modes, and also when a snapshot 
file is open.

Typing on the <Tab> and <Shift>+<Tab> keys on the computer keyboard can be used 
to navigate back and forth through setpoints. 

Flyover Text
When the mouse cursor is located over a setpoint, flyover text will appear for seven 
seconds to describe the setpoint, including the range for numerical setpoints. When the 
mouse is located over a command button, flyover text will also appear to describe the 
function of that button. Flyover text is provided to facilitate the data-entry process. An 
example of flyover text is shown in Figure 70.

Figure 70 . Sample flyover text .

Working with 
Setpoints and 
Setpoint Files
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Color Change of Setpoints Border
The color of the border of a setpoint field changes according to the following rules:

At any time if a setpoint field holds a value within the valid range but is different from 
the “original” state of the field, the border will change to yellowish orange. See Figure 71.

Figure 71 . The border in yellowish orange when the value differs from the “original” state .

The “original” state of a setpoint field, again, is defined as:

 ● Standalone (offline) mode—This is the default setpoint the Standalone mode always 
starts with each time the software is launched.

 ● Connected (online) mode—This is the active setpoint currently residing in the 
TripSaver II recloser.

 ● When a snapshot file is open—This is the setpoint saved in the snapshot file. 

Setpoint changes will not take effect in the connected recloser until they have been 
validated and applied. When applied, the changes become the new “original” state for the 
Connected (online) mode, and the yellowish-orange color will disappear.

When a setpoint field contains a value out of its valid range, the border will change to 
red. See Figure 72. That indicates an error that needs to be fixed. 

Figure 72 . The border is red when the value is out of its valid range .

When the mouse cursor is located over a setpoint, the border will change to light blue. 
See Figure 73.

Figure 73 . The border is light blue when the cursor is over it .

There is one exception. If a data-entry field has a yellow-orange or red border, the 
border will not change to light blue.
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Out-of-Range Warning
When a value outside of the valid range is typed into a data-entry field, a warning message 
opens next to the field indicating the correct range and the degree of precision needed. See 
Figure 74. 

Figure 74 . The out-of-range warning .

The warning message disappears on the next mouse click. Note: The invalid value will 
be erased when navigating to another settings screen.

Save Setpoints 
A complete or partially completed set of setpoints can be saved, with one exception:

 ● If the process of selecting a TCC curve has been started, setpoints cannot be saved, 
and the Save Setpoints button will be grayed out until the curve-selection process is 
complete. 

TripSaver II Service Center Configuration Software allows saving a snapshot of all data 
from the control at a specific instant and viewing it later offline. The snapshot file has file 
extension .xdss.

Saving a snapshot is available only in the Connected (online) mode. The snapshot 
saved always has the same version number as the firmware version of the TripSaver II 
recloser where the snapshot file was generated.

A snapshot file can be opened in the Standalone (offline), the Connected (online) 
mode, or when another snapshot is already open. All snapshot firmware versions can be 
opened and viewed using the latest version of the service center configuration software.

Note: When opening a snapshot file under the Connected (online) mode, the recloser will 
be disconnected automatically, and no data will be applied to the connected TripSaver II 
recloser. Users can re-connect to the TripSaver II recloser after a snapshot file is open. See 
the “Connect to Device” section on page 29. 

The setpoints in a snapshot file can be edited and, when the editing is completed, it 
can be saved into a setpoint file. 

Working with a 
Snapshot File
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Informational and Settings Screens

The time-current characteristic (TCC) curves for the initial Trip operation, optional 
sequence coordination, and up to three Test operations are selected using the TCC Curve 
Settings screen, which is also the first screen to open when the software is launched. The 
five Trip operations are named: Initial Trip, Sequence Coordination, Test 1, Test 2, 
and Test 3 respectively. Setting fields for each Trip operation are grouped in separate 
areas identifiable by trip names shown on the left side of each area. See Figure 75.

Figure 75 . Setting fields for each Trip operation are grouped in separate areas .

The Initial Trip operation is required; if that is the only trip operation selected, the 
TripSaver II recloser will operate one time and then drop open (i.e., single shot to lockout). 
One of the available TCC curves listed in Appendix A on page 127 must be selected for 
the initial trip and for each of the additional tests to be added.

TCC Settings 
Screen
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Sequence Coordination
The optional Sequence Coordination feature maintains proper coordination between an 
upstream TripSaver II Cutout-Mounted Recloser and the downstream recloser when each 
is set with fast and slow TCC curves. If the downstream recloser operates, the upstream 
TripSaver II recloser will shift (without operating) from its Initial Trip curve setting to a 
user-configured (usually slower) Sequence Coordination time-current characteristic curve. 
The TripSaver II recloser will maintain its Sequence Coordination setting until the Coor-
dination Reset timer expires.

When the Sequence Coordination TCC is active and the Coordination Reset timer 
expires, it will afterwards revert to the Initial Trip TCC settings. More information about 
the Sequence Coordination feature with examples can be found in S&C Information 
Bulletin 461-50 “TripSaver® II Cutout-Mounted Recloser: Sequence Coordination Applica‑
tion Guide.”

Sequence coordination is enabled by checking the Enable Sequence Coordination 
check box. Sequence coordination uses the same TCC curves as are available for the 
Initial Trip and Test 1, 2, and 3 operations. A Coordination Reset Time setting must 
be entered (Default: 120 seconds). The Coordination Reset Time setting defines how 
long the recloser will stay in the Sequence Coordination TCC curve before reverting to the 
Initial Trip TCC curve. The range for the Coordination Reset Time setting is between 0.5 
and 1000 seconds. See Figure 76. The Sequence Coordination TCC curve will use the same 
Open Interval After Trip setting as the Initial Trip TCC curve.

Figure 76 . The Sequence Coordination settings .

Add/Remove a Test Operation
Remove a Test Operation. Click on the green Remove Last Test button at the bottom 
of the screen to remove the last Test operation from the test sequence. See Figure 77. 

Figure 77 . The Remove Last Test button .

Test operations can only be removed sequentially from the bottom up. For example, 
Test 2 cannot be removed without first removing Test 3. The Test 3 settings can be saved 
to the clipboard first by clicking on the Copy button located in the setting area for Test 3. 
Otherwise, settings will be lost when the curve is removed. The function of the Copy 
button is explained in the “Copy and Paste Feature” section on page 54.
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Add a Test Operation. Click on the green Add a Test button at the bottom of screen to 
add a new Test operation to the end of the test sequence. See Figure 78. Test operations 
can only be added sequentially from the top down.

Figure 78 . The Add a Test button .

Copy and Paste Feature
The Copy and Paste feature can be used to copy TCC curve settings from one trip opera-
tion to another trip operation. This eliminates the need to re-enter TCC curve  settings 
multiple times. Each trip operation has its own Copy and Paste buttons. See Figure 79. 
Note: The open interval between two adjacent operations is not copied.

Figure 79 . The Copy and Paste buttons .

Copy. To copy TCC curve settings to the clipboard, click on the Copy button for the oper-
ation being duplicated (e.g., Initial Trip or Test 1, etc.). The Copy button will not be active 
until a curve has been completely defined.

Paste. To paste TCC curve settings from the clipboard, click on the applicable Paste 
button. The Paste button will not be active until a Copy button is clicked.
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Open Interval and O/C Sequence Time
If the reclosing sequence consists of just the Initial Trip operation (i.e., single shot to 
lockout), the reset time does not need to be entered. If there are two or more Trip opera-
tions, the open interval must be entered between adjacent Trip operations in addition to 
the reset time. On the screen, the field for the Open Interval setting is located between 
two adjacent Trip operations; the field for the O/C Sequence Time setting is always 
located at the end of all Trip operations. See Figure 80.

Figure 80 . The Open Interval and O/C Sequence Time setting field locations .

Open Interval following Initial Trip, Test 1, or Test 2. Specify interrupter open time 
(in seconds) before it recloses after the initial Trip operation, after Test 1, or after Test 2, 
as applicable (Minimum value: 0.5; maximum value: 5 [or 30 for extended open interval-ca-
pable reclosers]). 
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O/C Sequence Time. Specify the reset time for the test sequence, in seconds (Minimum 
value: 0.5; maximum value: 1000). If a TripSaver II recloser remains closed upon comple-
tion of an action in the test sequence—and the overcurrent element has not picked up and 
started timing again within this setting—the test sequence counter will reset and the TCC 
curve will reset to its setting defined in the Trip operation. 

Note: An active O/C Sequence Time timer will not expire after a TripSaver II recloser 
loses power. It will continue counting down until the defined duration has been reached.

Default TCC Curve Settings
The software launches with a set of default TCC curve settings that match those 
programmed into every standard TripSaver II recloser before it leaves the factory. This is 
the starting point of the configuration process. The S&C default TCC curve settings are 
shown below:

Initial Trip: Microprocessor Recloser S&C 104 curve; Minimum Trip Current: 100 A; Time 
Multiplier: x1; Reset Type: D/T (Definite Time); Reset Time: 0.1s; Advanced TCC Curve 
Setup: Off.

Open Interval After Initial Trip: 5s.

Sequence Coordination (Disabled): Microprocessor Recloser S&C 133 curve; Minimum 
Trip Current: 100 A; Time Multiplier: x2; Reset Type: D/T (Definite Time); Reset Time: 0.1s; 
Advanced TCC Curve Setup: Off.

Coordination Reset Time: 120s.

Test 1: Microprocessor Recloser S&C 104 curve; Minimum Trip Current: 100 A; Time 
Multiplier: x1; Reset Type: D/T (Definite Time); Reset Time: 0.1s; Advanced TCC Curve 
Setup: Off.

Open Interval After Test 1: 5s.

Test 2: Microprocessor Recloser S&C 133 curve; Minimum Trip Current: 100 A; Time 
Multiplier: x2; Reset Type: D/T (Definite Time); Reset Time: 0.1s; Advanced TCC Curve 
Setup: Off.

Open Interval After Test 2: 5s.

Test 3: Microprocessor Recloser S&C 133 curve; Minimum Trip Current: 100 A; Time 
Multiplier: x2; Reset Type: D/T (Definite Time); Reset Time: 0.1s; Advanced TCC Curve 
Setup: Off.

O/C Sequence Time: 15s.

These default settings for the setup software used while in the Standalone (offline) 
mode can be changed in the Standalone tab under the Options feature. See the Options 
feature under the Tools menu.
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Clearing Settings
To clear settings, either remove the Trip operation and then reinstate it using the Remove 
Last Test and Add a Test buttons, or select the Blank option under the Emulated 
Device selection menu for that Trip operation, as shown in Figure 81. 

Figure 81 . The blank option for clearing the TCC setting .

All existing settings will be erased. See Figure 82. Note: Any unwanted curve must 
be removed before applying new settings to a TripSaver II recloser. Leaving a curve added 
with completely blank settings will not allow the settings to be applied.

Figure 82 . The TCC setting erased .
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Configuring a Trip Operation
When a test is added, a new configuration area for that Test operation will be displayed, 
but with only two user-configurable fields available at the beginning—the Emulated 
Device drop-down menu and the Open Interval setting between the newly added Trip 
operation and the previous Trip operation. See Figure 83. For the Emulated Device drop-
down menu, select one of the following four options (additional user-configurable fields 
will be displayed depending on what is selected):

 ● Microprocessor Recloser

 ● Fuse Link

 ● Hydraulic Recloser

 ● Blank (explained in the “Clearing Settings” section on page 57.)

Figure 83 . The selections for an emulated device .

Note: When changing the selection for Emulated Device options at any time when config-
uring a Trip operation, all settings entered for that Trip operation will be erased. However, 
the Open Interval field can be edited independently.
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Selecting a Microprocessor Recloser Curve
Emulated Device. Select the Microprocessor Recloser option. See Figure 84.

Figure 84 . The Microprocessor Recloser option selected .

Inverse Segment. A new Inverse Segment field will open after the Microprocessor 
Recloser option is selected under the Emulated Device pull-down menu. See Figure 85.

Figure 85 . The Inverse Segment field .

Select various inverse curve segments from the list or select the DefiniteTime option. 
The term “S&C,” if present, means the inverse curve segment is an S&C-developed data-
points-based emulation of the TCC curve published by the recloser manufacturer. If the 
DefiniteTime option is selected, only the Definite Time-related setting fields will be 
displayed.

Note: When an Inverse Segment setting is selected, the curve-selection process 
is completed and the Test operation can be copied to the clipboard or saved to a 
setpoint file.

Inverse Segment
If an inverse curve segment is selected (e.g., S&C 105), additional fields will open, as 
shown in Figure 86. 

Figure 86 . The additional fields under Inverse Segment option .

Minimum Trip, A. Specify the current (in primary amperes) at which the inverse curve 
segment begins timing (Minimum value: 5; maximum value: 400). Note: Though the 
maximum value available is 400 A, the software will prompt with an overload warning of 
40 A for TripSaver II reclosers rated 40 A continuous, 100 A for TripSaver II reclosers rated 
100 A continuous, and 200 A for TripSaver II reclosers rated 200 A continuous.

Some curves may have different ranges for the Minimum Trip setting, as indicated 
in the flyover text. This field is mandatory. The Minimum Trip current for 40-A and 100-A 
continuous TripSaver II reclosers is 5 A. The Minimum Trip current for 200-A continuous 
TripSaver II reclosers is 10 A.

Time Multiplier. Specify the modifier for the inverse curve segment (Minimum value: 
0.01; maximum value: 15). Note: Some curves may have different ranges for the Time 
Multiplier setting, as indicated in the flyover text. This field is mandatory. 
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Reset Type. Select the reset method for the inverse curve segment from the drop-down 
list: “D/T” (Definite Time) or “E/M” (Electromechanical). (This is not to be confused with 
O/C Sequence Time setting. “Reset” here means how fast that curve will reset if it has 
picked up but the fault disappears before the TripSaver II recloser could trip.) This field is 
mandatory.

Reset Time, s. Specify the time delay (in seconds) before the inverse curve segment 
resets under D/T reset type (Minimum value: 0; maximum value: 1,000). This field is 
mandatory. 

Reset Time, s (TM1, I0A). When the Reset Type setting is E/M, the title of the reset 
time will be changed to “Reset Time, s (TM1, I0A).” The value specified here is the time 
delay (in seconds) before the inverse curve segment resets when the Time Multiplier 
setting is set at 1 and load current flowing is at 0 A (Minimum value: 0; maximum value: 
1,000). The actual reset time used by the Electromechanical Reset feature will be calcu-
lated using the following quadratic algorithm: 

Reset Time Reset Time ** Time Multiplier Time Multiplier

( (                                 ))
22

− 1− 1
Load CurrentLoad Current

Min TripMin Trip

Note: This formula will provide a “negative” value, but the absolute value should be 
considered.

This field is mandatory. See Figure 87.

Figure 87 . The Reset Time setting field for E/M Reset Type .

Advanced TCC Curve Setup (optional). (Click on the Advanced TCC Curve Setup 
button to expand/collapse area.) See Figure 88.

Figure 88 . The Advanced TCC Curve Setup fields for a microprocessor recloser.



Informational and Settings Screens

.  S&C Instruction Sheet 461-504  61

Time Adder (check box). Select this check box to enable the Time Adder setting. 

Time Adder, Time s. Specify a time modifier (in seconds) to add a constant time delay to 
the inverse curve segment. (Default: 0; minimum value: 0; maximum value: 0.25)

Max Time (check box). Select this check box to enable the Max Time setting. See 
Figure 88 on page 60. The Max Time setting enables the setting of a maximum time 
duration of the current before a trip will occur. This is helpful when TCC curves are 
designed where the load or fault must be sustained for long durations (seconds or 
minutes) when the current magnitude is near the Minimum Trip setting, before a protec-
tion Trip operation occurs according to the set TCC curve.

Max Time, Time s. Specify a maximum time (in seconds) to trip prior to inverse curve 
segment expiration. (Default: Disabled; minimum value: 0.2; maximum value: 180)

Low Current Cutoff (check box). Select this check box to enable low-current cutoff.

Low Current Cutoff, Current, A. Specify the current (in primary amperes) below which 
the inverse curve segment is truncated. The Low Cutoff Current setting will be the actual 
minimum trip current (Minimum value: 5; maximum value: 600). Note: This value must be 
greater than the minimum trip current of the inverse curve segment and smaller than the 
High Current Cutoff setting.

Definite Time 1 (Inst Trip) (check box). Select this check box to enable the Definite 
Time 1 element. For Instantaneous Trip mode, the settings depend on the emulated 
device, and the Minimum Trip, Coil Rating, or Ampere rating depending on the emulated 
device (microprocessor recloser, hydraulic recloser, or fuse respectively) and the setting is 
listed in the flyover text. Note: The Definite Time 1 element must be enabled before the 
Definite Time 2 element can be enabled. If the Definite Time 1 element is deselected, 
the Definite Time 2 element is deselected automatically.

Definite Time 1 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 1 element picks up (Minimum value: 5; maximum value: 6300). Note: This 
value must be greater than the Minimum Trip current, greater than the Low-Current Cutoff 
current, less than or equal to the interrupting rating of the recloser, and smaller than the 
High Current Cutoff setting.

Definite Time 1, Time s. Specify the time delay (in seconds) after which the Definite 
Time 1 element trips (Minimum value: 0; maximum value: 1000). Note: This value must be 
less than or equal to time on inverse curve segment at Definite Time 1 current.

Definite Time 2 (check box). Select this check box to enable the Definite Time 2 
element. Note: This check box is not active unless the Definite Time 1 element is 
enabled.

Definite Time 2 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 2 element picks up (Minimum value: 5; maximum value: 6,300). Note: This 
value must be greater than the Definite Time 1 current, less than or equal to the inter-
rupting rating of the recloser, and smaller than the High Current Cutoff setting.

Definite Time 2 Time, s. Specify the time delay (in seconds) after which the Definite 
Time 2 element trips (Minimum value: 0; maximum value: 1,000). Note: This value must be 
less than Definite Time 1 setting.
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For Definite Time
If the DefiniteTime setting is selected from the same Inverse Segment selection menu, 
additional fields will open, described below. See Figure 89. Note: When the Definite-
Time setting is selected, the test operation can be copied to the clipboard or saved to a 
setpoint file.

Figure 89 . The additional fields when DefiniteTime is selected under Inverse Segment .

Current, A. Specify the current (in primary amperes) at which the DefiniteTime setting 
begins timing (Minimum value: 5; maximum value: 400). This field is mandatory.

Time, s. Specify the time delay (in seconds) after which the DefiniteTime setting trips 
(Minimum value: 0; maximum value: 1,000). This field is mandatory. 

Reset Type. Select the reset method for the DefiniteTime setting from the drop-down 
list: “D/T” (Definite Time) or “E/M” (Electromechanical). (This not to be confused with 
the O/C Sequence Time setting. “Reset” here means how fast that curve will reset if it 
has picked up but fault disappears before the TripSaver II recloser could trip.) This field is 
mandatory. 

Reset Time, s. Specify the time delay (in seconds) before DefiniteTime setting resets 
under “D/T reset type” (Minimum value: 0; maximum value: 1,000). This field is mandatory. 

Reset Time, s (I0A). When the Reset Type setting is “E/M”, the title of the Reset Time 
field will be changed to “Reset Time, s (I0A).” The value specified here is the time delay 
(in seconds) before the DefiniteTime element resets when load current flowing is at 0 A 
(Minimum value: 0; maximum value: 1,000). The actual reset time used by the electrome-
chanical reset will be calculated using the following quadratic algorithm: the value in this 
field/(the load current / the current entered)^2 - 1). This field is mandatory. See Figure 90.

Figure 90 . The DefiniteTime Reset Time setting field for E/M Reset Type .
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Advanced TCC Curve Setup (optional). Click on the words to expand/collapse area. See 
Figure 91.

Figure 91 . The Advanced TCC Curve Setup fields when “DefiniteTime” is selected under 
Inverse Segment .

Time Adder (check box). Select this check box to enable time adder.

Time Adder, Time s. Specify a time modifier (in seconds) to add a constant time delay to 
the inverse curve segment. (Default: 0; minimum value: 0; maximum value: 0.25)

Max Time (check box). Select this check box to enable the Max Time setting. The Max 
Time setting enables the setting of a maximum time duration of the current before a trip 
will occur. This is helpful when TCC curves are designed where the load or fault must be 
sustained for long durations (seconds or minutes) when the current magnitude is near the 
minimum trip threshold, before a Protection Trip operation occurs according to the set 
TCC curve. When the Max Time setting is applied and a fault event occurs, either the Max 
Time setting or the TCC curve will cause the recloser to trip, whichever is fastest.

Max Time, Time s. Specify a maximum time (in seconds) to trip prior to inverse curve 
segment expiration. (Default: Disabled; minimum value: 0.2; maximum value: 180)

Low Current Cutoff (check box). Select this check box to enable low-current cutoff. 

Low Current Cutoff, Current, A. Specify the current (in primary amperes) below which 
the inverse curve segment is truncated. The Low Cutoff Current setting will then be the 
actual minimum trip current (Minimum value: 5; maximum value: 600). Note: This value 
must be greater than the minimum trip current of the inverse curve segment and smaller 
than the High Current Cutoff setting. 

Definite Time 1 (Inst Trip) (check box). Select this check box to enable the Definite 
Time 1 element. With additional definite times, it is possible to reduce the uncertainty of 
the protection at high fault currents and improve coordination between multiple devices.
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The following examples show the same 100ST fuse curve with no additional definite time, 
with one additional definite time, and with two additional definite times:

Figure 92 . Example of a 100ST Fuse curve without definite times .
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Figure 93 . Example of a 100ST fuse curve with one definite time

Figure 94 . Example of a 100ST fuse TCC curve with two definite times .
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Note: The Definite Time 1 element must be enabled before the Definite Time 2 element 
can be enabled. If the Definite Time 1 element is deselected, the Definite Time 2 
element is deselected automatically.

Definite Time 1 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 1 element picks up (Minimum value: 5; maximum value: 6300). Note: This 
value must be greater than the Minimum Trip current, greater than the Low-Current Cutoff 
current, less than or equal to the interrupting rating of the recloser, and smaller than the 
High Current Cutoff setting.

Definite Time 1, Time s. Specify the time delay (in seconds) after which the Definite 
Time 1 element trips (Minimum value: 0; maximum value: 1000). Note: This value must be 
less than or equal to time on inverse curve segment at Definite Time 1 current.

Definite Time 2 (check box). Select this check box to enable the Definite Time 2 
element. Note: The Definite Time 2 element must be enabled before the Definite Time 3 
element can be enabled. If the Definite Time 2 element is deselected, the Definite 
Time 3 element is deselected automatically.

Definite Time 2 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 2 element picks up (Minimum value: 5; maximum value: 6,300). See 
Figure 91 on page 63. Note: This value must be greater than the DefiniteTime Current 
setting, less than or equal to the interrupting rating of the recloser, and smaller than the 
High Current Cutoff setting.

Definite Time 2 Time, s. Specify the time delay (in seconds) after which the Definite 
Time 2 element trips. (Minimum value: 0; maximum value: 1,000; precision to 10 decimal 
places) See Figure 91 on page 63. Note: This value must be less than the DefiniteTime 
setting.

Definite Time 3 (check box). Select this check box to enable the Definite Time 3 
element. Note: This field is not active unless the Definite Time 2 element is enabled.

Definite Time 3 Current, A. Specify current (in primary amperes) at which the Definite 
Time 3 element picks up (Minimum value: 5; maximum value: 6,300). Note: This value 
must be greater than the Definite Time 2 Current setting, less than or equal to the inter-
rupting rating of the recloser, and smaller than the High Current Cutoff setting.

Definite Time 3 Time, s. Specify the time delay (in seconds) after which the Definite 
Time 3 element trips (Minimum value: 0; maximum value: 1,000; precision to 10 decimal 
places). Note: This value must be less than Definite Time 2 setting time. 

Note: When changing the selection for Inverse Segment setting at any time, all settings 
entered for that trip operation except the Emulated Device setting will be erased.
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Selecting a Fuse Link Curve
The following describes how to select the fuse link curve:

Emulated Device. Select the Fuse Link option from the Emulated Device pull-down 
menu. See Figure 95.

Figure 95 . The Fuse Link option .

A new Speed field and an Ampere Rating field will open. See Figure 96. 

Figure 96 . The Speed and Ampere Rating fields .

Speed. Select the fuse link speed from the list in the Speed pull-down menu. See 
Figure 97.

Figure 97 . The Speed pull-down menu .

Ampere Rating. Select a fuse link ampere rating from the list. For fuse links, the 
minimum trip current is about twice the ampere rating. See Figure 98. Note: This field is 
not active unless a Speed type for fuse link has been selected. When changing the Speed 
setting at any time, all data entered in the Ampere Rating pull-down menu and the 
optional Advanced TCC Curve Setup setting will be erased.

Figure 98 . The Ampere Rating drop-down menu .

Note: When the ampere rating has been selected, the curve selection process is 
completed, and the test operation can be copied to the clipboard or saved to a setpoint file. 
An optional Advanced TCC Curve Setup field will also open.



Informational and Settings Screens

68  S&C Instruction Sheet 461-504  .

Advanced TCC Curve Setup (optional). (Click on the words to expand/collapse area.) 
See Figure 99.

Figure 99 . The Advanced TCC Curve Setup when Fuse Link is selected under 
Emulated Device .

Time Multiplier (Check box). Select this check box to enable the Time Multiplier 
setting.

Time Multiplier. Specify modifier for inverse curve segment. (Minimum value: 0.01; 
maximum value: 15)

Reset (Check box). Select this check box to enable the Reset setting.

Reset Type. Select the reset method for inverse curve segment. (Default: D/T Definite 
Time, (D/T) Definite Time, or (E/M) Electromechanical)

Reset Time, s. Specify the time delay before inverse curve segment resets (in seconds). 
(Default: 0.1; minimum value: 0; maximum value: 1000)

Time Adder (check box). Select this check box to enable the Time Adder setting. 

Time Adder, Time, s. Specify a time modifier (in seconds) to add a constant time delay to 
the inverse curve segment. (Default: 0; minimum value: 0; maximum value: 0.25)

Max Time (check box). Select this check box to enable the Max Time setting. The Max 
Time setting enables the setting of a maximum time duration of the current before a trip 
will occur. This is helpful when TCC curves are designed where the load or fault must be 
sustained for long durations (seconds or minutes) when the current magnitude is near the 
minimum trip threshold, before a protection Trip operation occurs according to the set 
TCC curve. When the Max Time setting is applied and a fault event occurs, either the Max 
Time setting or the TCC curve will cause the recloser to trip, whichever is fastest.

Max Time, Time, s. Specify a maximum time (in seconds) to trip prior to inverse curve 
segment expiration. (Default: Disabled; minimum value: 0.2; maximum value: 180)

Low Current Cutoff (check box). Select this check box to enable low-current cutoff.

Low Current Cutoff, Current, A. Specify the current (in primary amperes) below which 
the inverse curve segment is truncated. The Low Cutoff Current setting will then be the 
actual minimum trip current. (Minimum value: 5; maximum value: 600) Note: This value 
must be greater than the minimum trip current of the inverse curve segment and smaller 
than the High Current Cutoff setting. 
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Definite Time 1 (Inst Trip) (check box). Select this check box to enable the Definite 
Time 1 element. For Instantaneous Trip, the settings depend on the emulated device, 
and the Minimum Trip, Coil Rating, or Ampere rating, depending on the emulated device 
(microprocessor recloser, hydraulic recloser, or fuse respectively) and the setting is 
listed in the flyover text. Note: The Definite Time 1 element must be enabled before the 
Definite Time 2 element can be enabled. If the Definite Time 1 element is deselected, 
the Definite Time 2 element is deselected automatically.

Definite Time 1 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 1 element picks up (Minimum value: 5; maximum value: 6300). Note: This 
value must be greater than the Minimum Trip current, greater than the Low Current Cutoff 
current, less than or equal to the interrupting rating of the recloser, and smaller than the 
High Current Cutoff setting.

Definite Time 1, Time, s. Specify the time delay (in seconds) after which Definite 
Time 1 element trips (Minimum value: 0; maximum value: 1000). Note: This value must 
be less than or equal to time on inverse curve segment at the Definite Time 1 Current 
setting.

Definite Time 2 (check box). Select this check box to enable the Definite Time 2 
element. Note: This check box is not active unless the Definite Time 1 element is 
enabled.

Definite Time 2 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 2 element picks up (Minimum value: 5; maximum value: 6,300). Note: 
This value must be greater than the Definite Time 1 Current setting, less than or equal to 
the interrupting rating of the recloser, and smaller than the High Current Cutoff setting.

Definite Time 2 Time, s. Specify the time delay (in seconds) after which the 
Definite Time 2 element trips (Minimum value: 0; maximum value: 1,000). Note: This 
value must be less than Definite Time 1 setting.

Selecting a Hydraulic Recloser Curve
The following describes how to configure the Hydraulic Recloser curve:

Emulated Device. Select the Hydraulic Recloser option from the Emulated Device 
pull-down menu. See Figure 100.

Figure 100 . The Hydraulic Recloser option .

New Inverse Segment and Coil Rating fields will open after the Hydraulic 
Recloser option is selected from the Emulated Device pull-down menu. See Figure 101.

Figure 101 . The Inverse Segment and Coil Rating fields .
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Inverse Segment. Select inverse curve segment from the list. It’s identified as follows: 
“x-y”, where “x” indicates the recloser type (e.g., H, L, E, etc.) and the “y” indicates the 
specific TCC curve (e.g., A, B, C, or D). See Appendix A on page 127 for curve definitions. 
For example, in Figure 102, for an H recloser, an A curve has been selected.

Figure 102 . The Inverse Segment drop-down list .

Coil Rating. Select a coil rating from the drop-down list. For hydraulic reclosers, the 
minimum trip current of the inverse segment is twice the coil rating. See Figure 103. 

Note: This field is not active unless a hydraulic recloser Inverse Segment option has 
been selected. When changing the selection for the Inverse Segment setting at any time, 
the coil rating selected will be removed. When the coil rating is selected, the curve selec-
tion process is complete and the test operation can be copied to the clipboard or saved to 
a setpoint file.

Figure 103 . The Coil Rating drop-down list .

Advanced TCC Curve Setup (optional). Click on the words to expand/collapse area. See 
Figure 104.

Figure 104 . The Advanced TCC Curve Setup when Hydraulic Recloser is selected under 
Emulated Device .

Time Multiplier (Check box). Select this check box to enable the Time Multiplier 
setting. 

Time Multiplier. Specify modifier for inverse curve segment (Minimum value: 0.01; 
maximum value: 15).

Reset (Check box). Select this check box to enable the Reset setting. 

Reset Type. Select the reset method for inverse curve segment. (Default: D/T Definite 
Time, (D/T) Definite Time, or (E/M) Electromechanical)

Reset Time, s. Specify the time delay before inverse curve segment resets (in seconds). 
(Default: 0.1; minimum value: 0; maximum value: 1000)
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Time Adder (check box). Select this check box to enable time adder.

Time Adder, Time, s. Specify a time modifier (in seconds) to add a constant time delay to 
the inverse curve segment. (Default: 0; minimum value: 0; maximum value: 0.25)

Max Time (check box). Select this check box to enable the Max Time setting. The Max 
Time setting enables the setting of a maximum time duration of the current before a trip 
will occur. This is helpful when TCC curves are designed where the load or fault must be 
sustained for long durations (seconds or minutes) when the current magnitude is near the 
minimum trip threshold, before a protection Trip operation occurs according to the set 
TCC curve. When the Max Time setting is applied and a fault event occurs, either the Max 
Time setting or the TCC curve will cause the recloser to trip, whichever is fastest.

Max Time, Time, s. Specify a maximum time (in seconds) to trip prior to inverse curve 
segment expiration. (Default: Disabled; minimum value: 0.2; maximum value: 180)

Low Current Cutoff (check box). Select this check box to enable low-current cutoff. 

Low Current Cutoff, Current, A. Specify the current (in primary amperes) below which 
the inverse curve segment is truncated. (Minimum value: 5; maximum value: 600) Note: 
This value must be greater than the minimum trip current of the inverse curve segment and 
smaller than the High Current Cutoff setting. 

Definite Time 1 (Inst Trip) (check box). Select this check box to enable the Definite 
Time 1 element. For Instantaneous Trip, the settings depend on the emulated device, 
and the Minimum Trip, Coil Rating, or Ampere rating depending on the emulated device 
(microprocessor recloser, hydraulic recloser, or fuse respectively) and the setting is 
listed in the flyover text. Note: The Definite Time 1 element must be enabled before the 
Definite Time 2 element can be enabled. If the Definite Time 1 element is deselected, 
the Definite Time 2 element is deselected automatically.

Definite Time 1 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 1 element picks up. (Minimum value: 5; maximum value: 6300) Note: This 
value must be greater than the Minimum Trip current, greater than the Low Current Cutoff 
current, less than or equal to the interrupting rating of the recloser, and smaller than the 
High Current Cutoff setting.

Definite Time 1, Time, s. Specify the time delay (in seconds) after which Definite 
Time 1 element trips. (Minimum value: 0; maximum value: 1000) Note: This value must 
be less than or equal to time on inverse curve segment at the Definite Time 1 Current 
setting.

Definite Time 2 (check box). Select this check box to enable the Definite Time 2 
element. Note: This check box is not active unless the Definite Time 1 element is 
enabled.

Definite Time 2 Current, A. Specify the current (in primary amperes) at which the 
Definite Time 2 element picks up (Minimum value: 5; maximum value: 6,300). Note: This 
value must be greater than the Definite Time 1 Current setting, less than or equal to the 
interrupting rating of the recloser, and smaller than the High Current Cutoff setting.

Definite Time 2 Time, s. Specify the time delay (in seconds) after which the Definite 
Time 2 element trips. (Minimum value: 0; maximum value: 1,000) Note: This value must 
be less than the Definite Time 1 Time setting.
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NOTICE

In service center configuration software versions 1 .6 and earlier, the MODE-
SELECTOR lever in the Down position or in R-NR mode would not go through the 
reclosing sequence but would operate instantaneously in response to a Trip event 
using the current setting set under the Initial Trip trip-operation field on the TCC 
Curve Setting screen . (See the “TCC Settings Screen” section on page 52 .) The 
new NR Curve Settings screen allows the user to program different TCC curves 
specifically for the MODE-SELECTOR lever when in NR or R-NR mode . 

The NR Curve Settings screen is where the curves used by the TripSaver II recloser when 
the MODE-SELECTOR lever is in the Down position or the recloser is in R-NR mode are 
set. See Figure 105. All curves in the NR Curve Settings screen are set the same and have 
the same setting ranges as the curves in the TCC Curve Settings screen.

Figure 105 . The NR Curve Settings screen .

Standard NR
The Standard NR setting allows the user to select any curve in the library when NR or 
R-NR mode are active. See Figure 106 on page 73. In TripSaver II recloser firmware 
version 1.6 and earlier, the NR curve was factory-set as the instantaneous curve and was 
not configurable. This TripSaver II recloser will use this setting when the MODE-SE-
LECTOR lever is in the Down position or when the recloser is in the R-NR mode. 

The recloser will not go through a reclosing sequence but will respond to the TCC 
set in the Standard NR setting field. The default setting is illustrated in Figure 105 on 
page 72. 

NR Curve 
Settings Screen
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Note: To make the Standard NR setting behave as an instantaneous curve, select the 
Definite Time setting for the Inverse Segment mode, and make sure the minimum trip 
value of the Standard NR setting is the same as the minimum trip value of the initial trip 
curve, as shown in Figure 80 on page 55.

Figure 106 . The Standard NR setting field .

Post Fault Wakeup NR
The Post Fault Wakeup NR setting is configured when a separate curve is desired when 
the TripSaver II recloser is energized or is closed into its mounting after a drop-open 
event occurs. See Figure 107. This setting will be used by the TripSaver II recloser when 
the MODE-SELECTOR lever is in the Down position or when the recloser is in the R-NR 
mode. After 10 cycles, if a current above the Current, A setting is not detected, the Post 
Fault Wakeup TCC curve will revert to the Standard NR curve settings. 

Figure 107 . The Post Fault Wakeup NR setting field .

The Post Fault Wakeup NR setting will be used after the recloser has dropped open 
in response to fault current, or another event that results in the recloser dropping open 
(i.e. LMO or Gang Operation). In situations where the recloser is waking up or is closed 
into the mounting after being de-energized when it did not experience a drop open event, 
the Cold Wakeup NR setting will be used. See Figure 108 on page 74. 

If a Post Fault Wakeup NR setting is not required, set the TCC curve to the same 
settings as the Standard NR TCC setting.
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Cold Wakeup NR
The Cold Wakeup NR setting is configured when a separate curve is desired in response 
to a cold wakeup of the TripSaver II recloser. See Figure 108. In most cases, this is a slower 
curve. This setting will be used by the TripSaver II recloser when the MODE-SELECTOR 
lever is in the Down position or when the recloser is in the R-NR mode. After 10 cycles, 
if a current above the Current, A setting is not detected, the Cold Wakeup NR curve will 
revert to the Standard NR curve. 

Figure 108 . The Cold Wakeup NR setting field .

The Cold Wakeup TCC curve will not be used in a “post-fault” situation, where the load 
is being picked up after the TripSaver II recloser has previously dropped open. In those 
cases, the Post Fault Wakeup NR curve will be used. See Figure 107 on page 73. 

If a Cold Wakeup NR setting is not required, set the TCC curve to the same settings 
as the Standard NR setting.

The TripSaver II recloser features a Sectionalizing function in both the 4-kA and 6.3-kA 
rated models. When enabled, a TripSaver II recloser will start its secondary protection 
function—the Sectionalizing function—over a user-specified range of fault currents 
when the source-side circuit breaker or recloser for whatever reason trips faster than the 
TripSaver II recloser’s TCC overcurrent protection. It will count the number of operations 
of the source-side circuit breaker or recloser and will drop open after a user-specified 
number of counts. The Sectionalizing Settings screen is shown in Figure 109.

Figure 109 . The Sectionalizing Settings screen .

Note: The Sectionalizing feature serves as backup protection that works in parallel 
with the TCC curve overcurrent protection. Enabling this feature does not automatically 
switch the TCC curve overcurrent protection off and make the TripSaver II recloser a pure 
sectionalizer. Instead, the TripSaver II recloser will begin to operate as a pure sectionalizer 
for load or fault current that exceeds the High Current Cutoff setting. 

Sectionalizing 
Settings Screen
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An example of how the TripSaver II recloser will behave is shown in Figure 110. In this 
example, the Sectionalizing mode starting current is set to its lowest setting of 10 A, and 
the High Current Cutoff setting is set at its lowest value of 400 A. The initial trip (TCC0) 
curve will still provide protection at currents less than 10 A.

Figure 110 . An example of the Sectionalizer mode behavior .

Both the High Current Cutoff setting and Sectionalizing mode starting currents are 
global and apply to each trip in the protection sequence. 

In the zone between 10 A and 400 A, if the upline protective device is faster than the 
TripSaver II recloser’s initial trip (TCC0), the upline device will interrupt the fault and the 
downline TripSaver II recloser will increment its sectionalizer count by one. But if the 
downline TripSaver II recloser is faster than the upline protective device, the downline 
TripSaver II recloser will interrupt the fault and will increment its protection sequence 
counter by one. 

In the example shown in Figure 110, when a load or fault current of 400 A or more is 
incurred, the TripSaver II recloser will act as a pure sectionalizer and will not interrupt. 
Instead, it will increment its Sectionalizing mode counts for each fault interrupted by the 
upline recloser. The deadline threshold for all TripSaver II recloser models is 3 A, meaning 
a fault current followed by a current at or below 3 A is considered a fault interrupted by 
the upline recloser. 
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Pure Sectionalizing mode occurs where the High Current Cutoff setting and 
Sectionalizing Mode feature overlap. It starts where the High Current Cutoff setting is 
equal to or greater than the Sectionalizing Mode Starting Current setting. The lowest 
value the High Current Cutoff setting can be set equal to the Sectionalizing mode 
starting current is 400 A. To create a zone where the TripSaver II recloser performs like a 
pure sectionalizer, set the High Current Cutoff setting to the same value as the Section-
alizing Mode Starting Current setting. The lowest the High Current Cutoff setting can 
be set equal to the Sectionalizing mode starting current is 400 A.

High Current Cutoff
The High Current Cutoff setting is a global setting that applies to all TCC curves 
selected. When enabled, the overcurrent elements for all TCC curves including NR curves 
will not time and trip on fault current above the value entered. Protection will be provided 
by the upstream device. See Figure 109 on page 74.

High Current Cutoff (Enabled or Disabled). Select the Enabled value to enable the 
High Current Cutoff setting for all TCC curves.

High Current Cutoff, Current A. Specify current (in amperes) above which the Over-
current element of all enabled TCC curves will not time and trip (Minimum value: 400; 
maximum value: 6,300).  This value must be less than or equal to the interrupting rating 
of the recloser. It also must be equal or greater than the Sectionalizing Mode Start 
Current setting to avoid a gap in protection.

Sectionalizing Mode
Sectionalizing Mode. Select the Enabled or Disabled option from the Sectional-
izing Mode pull-down menu list. See Figure 109 on page 74. Note: When toggling this 
selection at any time when configuring the sectionalizing settings, all data entered for 
sectionalizing settings will be erased. 

Sectionalizing Mode Counts. Specify the number of source-side circuit breaker or 
recloser trip operations the TripSaver II recloser will count up to before dropping open. 
(Minimum value: 1; maximum value: 9, integer). 

Sectionalizing Mode Reset Time, s. Specify the length of time the Sectionalizing logic 
waits for an additional sectionalizing event to occur before it resets, in seconds. (Minimum 
value: 0.5; maximum value: 1,000) 

Sectionalizing Mode Starting Current, A. Specify the current, in primary amperes, at 
which the Sectionalizing mode starts. (Minimum value: 10; maximum value: 6,500) Note: 
This value must be less or equal to the High Current Cutoff setting to avoid a gap in 
protection.
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The TripSaver II recloser uses a non-volatile liquid-crystal-display (LCD) to show various 
status and operational information. The screen has two operating modes: Normal screen 
and Display screen. The LCD shows the Normal screen most of the time. The Display 
screen parameters may be viewed by toggling the MODE SELECTOR. TripSaver II 
reclosers will scroll through the user-configurable Display screen items the specified 
number of times before the screen returns to the Normal screen.

Use the LCD Screen Settings screen to select the desired screens from a list of avail-
able LCD Display screen items. See Figure 111.

Figure 111 . The LCD Screen Settings screen .

Invert Screen When Dropped-open (check box). Select this check box to invert the 
LCD screen when the connected TripSaver II recloser is in the Dropped Open (hori-
zontal) position. The inverted display is easier to read from the ground when a TripSaver II 
recloser is in the Dropped Open position.

Screen When Dropped Open. Select from the list the desired screen to display after a 
Drop Open event. 

See Appendix B on page 130 for the available options.

Language. Select from the list the display language for the LCD screen. (Note: This is 
not the language for the configuration software.) The following languages are supported: 
English, Spanish, Portuguese, French, Chinese, and Arabic. 

LCD Screen 
Settings Screen
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Normal Screen. Select from the list. Two Normal screen options are available. The Normal screen is the screen that 
displays most of the time. See Figure 111 on page 77 and Table 1.

Table 1 . Normal Operation Screens (Default setting)

Screen Name Description

Primary Normal screen
For standard TripSaver II reclosers, four operating parameters are 
displayed: Vacuum interrupter status (Open or Closed), Mode selector 
status (Auto or NR)

Load current The load current in primary amperes is displayed .

Last fault magnitude

The fundamental-frequency magnitude of the last fault current in 
primary amperes, as measured just before the vacuum interrupter 
opens, is displayed . The fault current unit is amperes for faults smaller 
than 1000 A and kiloamps with two decimals for faults greater than 
or equal to 1000 A . This was done because of the limited horizontal 
space on the LCD screen .

Number of Open operations The total number of vacuum interrupter Open operations is displayed .

Remaining contact wear in % The remaining vacuum interrupter contact wear, in percent, is 
displayed .

The LCD Temperature screen . The temperature is shown, in degrees Celsius . 

Sectionalizing mode counts:

This screen displays the preset number of source-side circuit breaker 
or recloser operations the TripSaver II recloser will count up to before 
dropping open . This screen is automatically skipped if Sectionalizing 
mode is disabled .
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Software versions Three pieces of information about software version are displayed: 
Application, Bootloader, and Radio Frequency Microcontroller Unit .

Cycles back to Closed | Auto screen

Transceiver ID This is the communication ID .

TripSaver II Cutout Mounted Reclosers built before 8-30-2024 may include Alternate Normal screens. 

Table 2 . Alternate Normal screens

Screen Name Description

Alternate Normal screen 
(Secondary Normal screen)
Vacuum interrupter state—

Open

The vacuum interrupter is in an Open state . 

Alternate Normal screen 
(Secondary Normal screen) 
  Vacuum interrupter state—

Close

The vacuum interrupter is in a Closed state . 

●

Alternate Normal screen 
(Secondary Normal screen) 
  Vacuum interrupter state—

Unknown

This is an unknown vacuum interrupter state . 

“Display” Screen Full Sequence Repeats. Select the number of times the entire sequence of Display screen items is 
repeated. See Figure 111 on page 77. The Display screen is initiated by any operation of the MODE SELECTOR lever.

Each “Display” Screen Duration. Select the length of time, in seconds, each Display screen item is displayed before 
the screen scrolls to the next item.
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Selecting “Display” Screen items
The lower half of this setting screen is where the Display screen items are selected. See Figure 111 on page 77.

Available Screens. This list displays the selection of screens that can be added to the Display Screen sequence. See 
Appendix B on page 130 for the available options. An item can be selected and added to the Display Screen sequence 
by clicking on it. The clicked item will be highlighted in blue color. See Figure 112. Multiple items can be selected simul-
taneously.

Figure 112 . The list of available items for the Display Screen mode .

Screens to Display. This is the list of items that will be displayed on the LCD screen under the Display Screen mode. 
See Figure 113. Multiple items can be selected simultaneously. Up to 32 items can be added to this list.

Figure 113 . The list of screens that will be displayed .
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Add. The Add button is used to add a highlighted item or a group of items from the Available Screens list to the Screens 
to Display list on the right. See Figure 114.

Figure 114 . The Add button .

The Add button is grayed out when no item in the Available Screens list has been highlighted.

Note: If an existing item or items in the Screens to Display list is highlighted before adding a new item over from 
the Available Screens list, the new item will be inserted below the highlighted item in the Screens to Display list. See 
Figure 115.

Figure 115 . A new item is always added under the highlighted existing item .
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Remove. Click on the Remove button to remove a highlighted item or items from the 
Screens to Display list. See Figure 116.

Figure 116 . The Remove button .

The Remove button is grayed out when no item in the Screens to Display list has been 
selected.

Up and Down Arrows. These are used to move highlighted items up or down in the 
Screens to Display list. See Figure 117.

Figure 117 . The Up and Down arrows .

Note: The Up arrow is grayed out when the selected item is already on the top of the list, 
and the Down arrow is grayed out when the selected item is already on the bottom of 
the list. 
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The arrows are also grayed out when no item in the Screens to Display list has been 
selected. See Figure 118.

Figure 118 . The arrows are grayed out when no items are selected .

Clear All. Click on this button to remove all items from the Screens to Display list. See 
Figure 118. 

The Display Screen mode will be disabled if no screens are added to the Screens to 
Display list.

LCD Screen Settings Screen—Default Settings
TripSaver II Service Center Configuration Software launches with a set of default LCD 
screen settings that match those programmed into the standard TripSaver II recloser 
before it leaves the factory. This is the starting point of the LCD configuration process. The 
default LCD screen settings are shown below.

Invert Screen When Dropped-Open: Off

Screen When Dropped-Open: Primary Normal screen

Language: English

“Normal” Screen: Primary Normal screen

“Display” Screen Full Sequence Repeats: 2 times

Each “Display” Screen Duration: 3 seconds

Screens to Display: Primary Normal, Load Current, Last Fault Magnitude, Number of 
Open Operations, Remaining Contact Wear in %, LCD Screen Temperature, Sectional‑
izing Mode Counts, Software Versions.
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The Status screen is available under the Connected (online) mode or when a snapshot 
file is open. When a TripSaver II recloser is connected, the Status screen will be the first 
screen to open, and it will populate with data from the TripSaver II recloser. The Status 
screen presents status information, a summary of TCC curve settings, and general recloser 
information. This screen is view-only; there are no data-entry fields. See Figure 119.

Figure 119 . The Status screen .

Status Information 
The status information is shown at the top section of this screen. See Figure 120.

Figure 120 . The Status information area .

Status Screen
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Photo. Depending on the TripSaver II recloser, a photo of either a 15-kV (15.5-kV max) or 
25-kV (29-kV max) recloser will be displayed. If a TripSaver II recloser is furnished with the 
Extended Open Interval option (“-O”), a black and white clock face icon indicating “30s” 
will be displayed on the top right side in the photo frame. See Figure 119 on page 84 and 
Figure 121.

15 kV 25 kV

Figure 121 . Photos of 15-kV and 25-kV TripSaver II reclosers .

Current, A. This is the instantaneous magnitude of the current flowing through the 
control, in primary amperes. It’s located below the photo. Current displayed will typically 
be 0 A~1 A when the TripSaver II recloser is being powered by the power module during 
configuration. See Figure 119 on page 84.

Interrupter Contacts. This indicates whether the vacuum interrupter contacts of the 
connected TripSaver II recloser are presently open or closed. Note: During a functional 
test, it is normal for the vacuum interrupter contacts to show “Transit,” which means the 
interrupter contacts are opening or closing.

Mode. This indicates the operational mode of the TripSaver II recloser: AUTO (lever up), 
NR (lever down), or R-NR (lever up). In Auto mode, a TripSaver II recloser will perform 
open or reclose operations according to the pre-selected TCC curves. In NR (Non-Reclose) 
and R-NR (Remote-Non-Reclose) mode, a TripSaver II recloser will not reclose; it will trip 
once on the applicable user-specified NR curve or the default instantaneous curve if the NR 
curve settings have not been configured (the minimum trip current comes from the initial 
trip curve) and then drop open. The TripSaver II recloser automatically resets approxi-
mately 2 seconds after it drops open.

Sectionalizing Mode. This indicates whether the Sectionalizing feature is presently 
enabled or disabled in the connected TripSaver II recloser. 

Sectionalizing Counts. This indicates the number of source-side circuit breaker or 
recloser tripping operations the enabled Sectionalizing feature counts up to before 
commanding a TripSaver II recloser to drop open. The field is grayed out if the Sectional-
izing feature is disabled. 

Battery Charge Level. This field is only displayed if a recloser is furnished with the 
Extended Open Interval option (“-O”). It indicates the battery state of charge, in 
percent. The battery state of charge is also represented by a blue “Battery Charge Level” 
bar at the bottom of the screen, similar to the “Main Cap Charge” bar. 
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Battery Status. This field is only displayed if a recloser is furnished with the Extended 
Open Interval  option (“-O”). It indicates the status of the battery that is used to support 
the extended open interval. 

OK: The battery is functioning normally.

Error: This indicates a battery problem.

# of Operations. This indicates the number of vacuum interrupter open operations regis-
tered in total. See Figure 119 on page 84.

Remaining Contact Wear in %. This indicates the remaining vacuum interrupter contact 
wear, in percent. 

Last Fault Current, A. This indicates the fundamental-frequency magnitude of the last 
fault, in primary amperes, measured just prior to the opening of the vacuum interrupter 
contacts. 

Status. This displays the status of the control. The following status messages can be 
displayed.

 ● OK: The TripSaver II recloser is functioning normally and is in the Idle state.

 ● Waiting to Open VI: This indicates the vacuum interrupter contacts are waiting 
to open.

 ● Waiting to Close VI: This indicates the vacuum interrupter contacts are waiting 
to close.

 ● Open Interval: This indicates the TripSaver II recloser is in the Open Interval state.

 ● Waiting to Drop Open: This indicates when TripSaver II recloser is waiting to 
drop open.

 ● Waiting to Reset Drop-Open: This indicates when TripSaver II recloser is waiting to 
reset the drop-open mechanism. This is a relatively short transient state.

 ● Dropped Open: This indicates the TripSaver II recloser has dropped open. This is a 
relatively short transient state, after which the status will go back to being OK.

 ● Error: This indicates an error has just occurred. This is a transient state and only 
temporarily displays immediately after an error event.

 ● Service Now: This appears when a TripSaver II recloser cannot release the drop-open 
mechanism after consecutive re-tries, when the vacuum interrupter contacts cannot 
open after consecutive re-tries, or when a TripSaver II recloser is no longer capable 
of interrupting a fault when remaining contact wear is at 0%. When a TripSaver II 
recloser enters the Service Now state, the LCD will be locked with a special Service 
Now screen: the right side of the screen will display the vacuum interrupter status (“O” 
for Open; “I” for Closed; “X” for an error situation when the recloser cannot sense the 
vacuum interrupter status) and the left side of the screen will display an “!” symbol, 
indicating immediate attention is needed. Rotating the MODE SELECTOR lever, 
applying a 9-Volt Lithium L522 battery, or applying the Service Center Configurability 
power module will not unlock the screen. When this occurs, follow the steps in the 
“Clearing the Service Now LCD Screen” section on page 115.
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Note: The Status field displays “OK” most of the time during configuration. Changes in 
status will be seen during a functional test. However, some of the fast transient events 
may not be captured on the screen. To optimize the performance of communications 
system, the software is designed to pull status information from the connected TripSaver II 
recloser only once per second. Therefore, some fast transient events may have already 
expired by the time TripSaver II recloser starts to transmit its latest status information to 
the software.

TCC Curve Summary
The “TCC Curve Summary” section is expanded by default. Users can collapse the section 
by clicking on the green title row. This screen summarizes the basic information of the 
configured TCC curves residing in the connected TripSaver II recloser. See Figure 122.

Figure 122 . The TCC Curve Summary area .

The following curve information is extracted from the connected recloser. 

 ● Emulated Device. The type of device the curve is emulating. It displays either Micro-
processor Recloser, Fuse Link, or Hydraulic Recloser. See Figure 123.

Figure 123 . The columns for emulated devices, curves, and pick-up characteristics
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 ● Curve. The specific curve used for each trip operation. It displays either the inverse 
segment selected for a microprocessor recloser emulation, the speed selected 
for a fuse link emulation, or the inverse segment selected for a hydraulic recloser 
emulation.

 ● Pickup Characteristics. The pickup characteristics for each trip operation. It 
displays either the minimum trip current for a microprocessor recloser emulation, 
ampere rating for a fuse link emulation, or coil rating for a hydraulic recloser emula-
tion. The Low Cutoff setting is also displayed, if enabled. 

General Device Information
The “General Device Information” section is collapsed by default. The section can be 
expanded by clicking on the green title located at the bottom part of the Status screen. See 
Figure 124.

Figure 124 . The General Device Information area .

When expanded, the following hardware and firmware related information of the 
connected TripSaver II recloser are displayed: 
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Hardware
Voltage Rating (Max), kV. This indicates the rated maximum voltage of the connected 
TripSaver II recloser. Either 15.5 kV or 29 kV is displayed. 

Continuous Current Rating, A. This indicates the continuous current rating of the 
connected TripSaver II recloser. This value will be either 100 A or 200 A. 

Interrupting Rating, Symm., kA. This indicates the interrupting rating in symmetrical 
kiloamps of the connected TripSaver II recloser. Either 4 kA or 6.3 kA is displayed. 

System Frequency, Hz. This indicates the frequency of the electrical system the 
connected TripSaver II recloser was configured to operate on by the factory. Either 50 Hz 
or 60 Hz is displayed. 

Serial Number. This indicates the serial number of the connected TripSaver II recloser. 

Unit Configured On. This indicates the time stamp the connected TripSaver II recloser 
was last configured on, in the format of MM/DD/YYYY HH:MM:SS.milliseconds. 

Note:  When using the service center configuration software to view a TripSaver II recloser 
for the first time, the Unit Configured On field will not be visible. To display the Unit 
Configured On field, complete the following steps:

STEP 1 . Go to Tools>Options menu and select the Communication tab.

STEP 2 . Uncheck the Split Profile Apply Messages check box. Then, click the 
Apply button.

STEP 3 . Go to the Connection menu and select the Disconnect option. 

STEP 4 . Reconnect to the TripSaver II recloser following the instructions in the “Connect 
to Device” section on page 29.

STEP 5 . Make a change to the device configuration. Any change will prompt the device to 
initialize the configuration date in the register. Validate the change according to 
the directions in the “Validate” section on page 32 and then click on the Apply 
button. The Unit Configured On field should now show the correct informa-
tion. See Figure 125.

Figure 125 . The Unit Configured On field .
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Original Catalog Number. This indicates the catalog number of the connected 
TripSaver II recloser when it left the factory. 

Firmware
TripSaver II DSP Application. This indicates the version of the DSP firmware the 
connected TripSaver II recloser is using. See Figure 124 on page 88.

TripSaver II Boot Loader. This indicates the version of the boot loader the connected 
TripSaver II recloser is using.

TripSaver II Transceiver Application. This indicates the version of the 802.15.4 trans-
ceiver application code the connected TripSaver II recloser is using.

USB Transceiver Application. This indicates the version of the 802.15.4 transceiver 
application code the USB transceiver is using.

The Event Logs screen provides eight different historical counts, including the number of 
interrupter operations and recloser drop-opens, of the connected TripSaver II recloser, and 
the duration and current level of the last 25 trip events. See Figure 126.

Figure 126 . The Event Logs screen .

Event Logs Screen
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Historical Counts
Number of Forced Interrupter Closes. This is the number of times the vacuum inter-
rupter has been manually reset using the service center configuration kit power module, 
cordless power module, or a 9-Volt Lithium L522 battery.

Number of Interrupter Open Operations due to Overcurrent. This is the number of 
times the vacuum interrupter contacts have opened because of an Overcurrent condition. 

Total Number of Interrupter Open Operations. This is the total number of times the 
vacuum interrupter contacts have opened.

Number of Drop-Opens due to Overcurrent. This is the number of times the 
TripSaver II recloser has dropped open because of an Overcurrent condition. See 
Figure 126 on page 90.

Number of Drop-Opens Due to Overload. This is the number of times the TripSaver II 
recloser has dropped open because of an Overload condition.

Number of Drop-Opens Due to Sectionalizing. This is the number of times the active 
Sectionalizing feature has counted up to the specified number and commanded the 
TripSaver II recloser to drop open.

Number of Drop-Opens Due to Local Manual Open. This is the number of times the 
TripSaver II recloser has dropped open, triggered by the Local Manual Open feature.

Total Number of Drop-Opens. This is the total number of times the TripSaver II recloser 
has dropped open, including the number of drop-opens during a functional test and trig-
gered by the Local Manual Open feature.
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Trip Events
The TripSaver II Service Center Configuration Software allows viewing the relative time 
stamp, duration, and current level of the last 25 interrupter trip events in the Trip Events 
table. When the table is full (loaded with 25 events), each new event will overwrite the 
oldest event in the table. For example, the 26th event will overwrite the first event shown 
in the table.

Note: While the Trip Events table only displays the last 25 interrupter trip events for user 
review, the firmware uses a separate memory to store full event logs for future engineering 
analysis use. The full log can be obtained by saving a snapshot file. 

The Trip Events table is located in the lower section of the Event Logs screen. Five 
columns of data are presented. See Figure 127.

Figure 127 . The Trip Events table .

Event. Each new event is assigned an event ID number in ascending order. The newest 
event is displayed in the top row of the table, and the oldest event is displayed in the 
bottom row. See Figure 128.

Figure 128 . The Event ID column .
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Tripped On. This indicates the event that caused the vacuum interrupter to trip. See 
Figure 129. 

Figure 129 . The column indicating the type of event the vacuum interrupter was tripped on .

The following events can be displayed.

 ● Overload. This indicates the vacuum interrupter tripped because of an Overload 
condition and the TripSaver II recloser dropped open.

 ● Sectionalizer. This indicates the vacuum interrupter tripped when the enabled 
Sectionalizing feature commanded the TripSaver II recloser to drop open after the 
preset count was reached.

 ● NR#0, NR#1, NR#2. This indicates the vacuum interrupter tripped because of an 
Overcurrent condition while the recloser was in NR or R-NR mode and the recloser 
dropped open.

 ● TCC0 or TCC1 or TCC2 or TCC3. This indicates which trip or test operation the 
TripSaver II recloser was on when the vacuum interrupter tripping event happened 
because of an Overcurrent condition under AUTO mode. TCC0: Initial Trip; TCC1: 
Test 1; TCC2: Test 2; TCC3: Test 3.

 ● Sequence Coordination trip operation. When the feature is configured and 
enabled, and when the TripSaver II recloser detects a fault that exceeds the TCC0 
minimum trip setting but the fault duration is not sufficient to cause TCC0 to trip, the 
TripSaver II recloser will assume the downline device has operated. The recloser will 
switch protection from TCC0 to its Sequence Coordination settings. 

If the fault isn’t cleared by the downstream device, the Sequence Coordination curve 
will start timing and trip. A Sequence Coordination trip operation will then show as 
“SC0” in the event log. See Figure 130. If the fault persists beyond SC0, the TripSaver II 
recloser will use the remaining settings in the protection sequence, including TCC1, TCC2, 
and TCC3, as programmed. For more information on the Sequence Coordination feature, 
see the description on page 53 and in S&C Information Bulletin 461-50, “TripSaver® II 
Cutout-Mounted Recloser: Sequence Coordination Application Guide.”

Figure 130 . An example of a sequence coordination trip in the Trip Events log .
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 ● LMO. This indicates the vacuum interrupter tripped because of a Local Manual 
Open command, and the TripSaver II recloser dropped open. 

 ● Suspicious. This indicates the S&C-determined flag for suspicious malicious local 
manual open attempts has been detected. The S&C-determined flag is defined as: 10 
consecutive MODE SELECTOR lever operations (moving the lever down and then 
back up is counted as two operations) within a 60-second period, when the Local 
Manual Open feature is disabled. The logic only monitors the condition when the 
recloser is vertical.

Relative Time, DD-HH:MM:SS.000. This indicates the relative time stamp of vacuum 
interrupter trip events in the format of days, hours, minutes, seconds and milliseconds. A 
TripSaver II recloser has an internal timer that starts when each recloser leaves the S&C 
factory. The timer saves a relative time stamp into memory immediately before the timer 
stops five hours after the recloser loses power. The internal timer will start from this saved 
time stamp when the TripSaver II recloser is powered up again. See Figure 131.

Figure 131 . The column displaying Relative Time timestamp .

Duration, ms. This indicates the duration (defined here) of each event shown in the 
Tripped On column, in milliseconds. See Figure 132.

Figure 132 . The column displaying duration for each event .
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 ● For Overcurrent (TCC0, TCC1, TCC2, TCC3, SC0, and the NR curves): This 
indicates the duration of the fault.

 ● For Overload: This indicates the duration of the overload drop-open event during 
which the current measured was above 100 A.

 ● For Sectionalizer: This indicates the duration during which the current measured 
during the last sectionalizing event, before the enabled Sectionalizing feature 
commanded the TripSaver II recloser to drop open, was above the Sectionalizing 
Mode Starting Current setpoint.

 ● For LMO: This value will be 0.

 ● For Suspicious: This value will be 0.

Current, A. This indicates the current level (defined here) of each event shown in the 
“Tripped On” column, in primary amperes. See Figure 133.

Figure 133 . The column displaying current level for each event .

 ● For Overcurrent (TCC0, TCC1, TCC2, TCC3, SC0, and the NR curves): This 
indicates the value of the current measured just before the vacuum interrupter 
contacts opened.

 ● For Overload: This indicates the value of the current measured just before the 
vacuum interrupter contacts opened.

 ● For Sectionalizer: This indicates the maximum value of the current measured during 
the last sectionalizing event before the enabled Sectionalizing feature commanded 
the TripSaver II recloser to drop open. 

 ● For LMO: This indicates the value of the load current measured just before the 
vacuum interrupter contacts opened by the Local Manual Open command.

 ● For Suspicious: This indicates the value of the load current measured when a suspi-
cious local manual open attempt was detected.

Clear All Events. Clicking on this button will clear the log for “Trip Events” in the 
connected TripSaver II recloser. This can be useful prior to deploying a TripSaver II 
recloser to a different location. This button is grayed out when viewing a snapshot file. See 
Figure 126 on page 90.

Note 1: The command executes immediately after clicking on the button. Save a snapshot 
before clearing the log.
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Note 2: Clicking on this button does not reset the relative timer.

Note 3: Clicking on this button does not erase anything from the memory used to store full 
event logs for use by S&C Technical Support.

Simulation-based functional tests can be performed on this screen to verify the vacuum 
interrupter and the drop-open mechanism respond correctly to the applied TCC curve 
settings. The Functional Test screen is shown in Figure 134.

Figure 134 . The Functional Test screen .

Specifically the test verifies the following:

 ● Main power supply capacitor inside the TripSaver II recloser will charge.

 ● Vacuum interrupter contacts will open.

 ● Vacuum interrupter contacts will close.

 ● Drop-open mechanism will respond correctly at the end of a permanent fault 
simulation.

 ● The test operations correctly sequence after the vacuum interrupter contacts 
are closed.

 ● The test operations reset at the end of a permanent fault simulation.

 ● The number of Trip operations matches the setting.

 ● The open interval matches the setting.

 ● The sequence-reset time matches the setting.

Note: This is not a primary injection test and does not involve any actual current.

Functional 
Test Screen
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Device Status
The upper section of the Functional Test screen monitors device status relevant to the 
functional test. See Figure 135.

Figure 135 . The Device Status area .

Interrupter Contacts. This indicates whether the vacuum interrupter contacts of the 
connected TripSaver II recloser are presently open or closed. Note: During a functional 
test, it's normal for the vacuum interrupter contacts to show “Transit,” which means the 
interrupter contacts are opening or closing. 

Mode. This indicates the position of the MODE SELECTOR lever: AUTO (up), 
Remote-NR (up), or NR (down). In AUTO mode, the TripSaver II recloser will perform an 
open and reclose operation during the functional test according to the applied TCC curves. 
In Remote-NR or NR (non-reclose) mode, the TripSaver II recloser will not reclose during 
the functional test; it will open the vacuum interrupter contacts instantaneously and 
release the drop-open mechanism after a simulation button is clicked. The TripSaver II 
recloser will drop open and reset itself afterward. 

Orientation. This indicates whether the TripSaver II recloser is closed into a fuse cutout 
mounting (in the Vertical position) or is in the Dropped-Open position (in the horizontal 
position). 

Status. This field displays the same status items as the Status screen. The following can 
be displayed:

 ● Ok: The TripSaver II recloser is functioning normally and is in the Idle state.

 ● Waiting to Open VI: This indicates the vacuum interrupter contacts are waiting 
to open.
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 ● Waiting to Close VI: This indicates the vacuum interrupter contacts are waiting 
to close.

 ● Open Interval: This indicates the state when the TripSaver II recloser is in the open 
interval.

 ● Waiting to Drop Open: This indicates when the TripSaver II recloser is waiting to 
drop open.

 ● Waiting to Reset Drop-Open: This indicates when TripSaver II recloser is waiting to 
reset the drop-open mechanism. This is a relatively short transient state.

 ● Dropped Open: This indicates the TripSaver II recloser has dropped open. This is a 
relatively short transient state, after which the status will go back to being “OK.”

 ● Service Now: This appears when the TripSaver II recloser cannot release the drop-
open mechanism after consecutive re-tries, when the vacuum interrupter contacts 
cannot open after consecutive re-tries, or when the TripSaver II recloser is no 
longer capable of interrupting a fault when remaining contact wear is at 0%. When 
the TripSaver II recloser enters the Service Now state, the LCD screen will display 
a special Service Now screen: the right side of the screen will display the vacuum 
interrupter status (“O” for open; “I” for closed), and the left side of the screen will 
display an “!” symbol, indicating immediate attention is needed. Rotating the MODE 
SELECTOR lever, applying a 9-Volt lithium L522 battery, or the service center config-
uration kit power module will not be able to unlock the screen. When this occurs, see 
the “Clearing the Service Now LCD Screen” section on page 115.

 ● Error: This indicates an error has just occurred. This is a transient state and only 
temporarily displays immediately after an error event. 

Note: During the functional test, some of the fast transient events may not be captured 
on the screen. To optimize the performance of communications subsystems, the software 
is designed to pull status information from the connected TripSaver II recloser only once 
per second. Therefore, some fast transient events may have already expired by the time 
TripSaver II recloser starts to transmit its latest status information to the software. 

Total Number of Interrupter Open Operations. This is the total number of times the 
vacuum interrupter contacts have opened. The value will increment by 1 for each inter-
rupter open operation performed during the functional test. 

Total Number of Drop-Opens. This is the total number of times the TripSaver II 
recloser has dropped open. The value will increment by 1 for each Drop Open operation 
performed during the functional test. 
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Functional Test
The lower section of the Functional Test screen is where the functional tests are 
performed. This section also monitors two additional pieces of information useful to the 
functional test. See Figure 136.

Figure 136 . The Functional Test command area .

Simulation Status. This field displays control status relevant to the functional test. 

The following can be displayed:

 ● Idle: The TripSaver II recloser is functioning normally and is in the Idle state.

 ● Charging Caps: This indicates the main power supply capacitors inside the 
TripSaver II recloser are charging. When this message is present, the blue “Main Caps 
Charge” bar at the bottom of the screen can be observed lengthening.

 ● Waiting to Reclose: This indicates the vacuum interrupter contacts are waiting 
to close.

 ● Waiting to Drop-open: This indicates the TripSaver II recloser is waiting to 
drop open.

Sequence Step. This field indicates which trip or test operation the connected 
TripSaver II recloser will use for the next fault simulation. TCC0: Initial Trip; TCC1: Test 1; 
TCC2: Test 2; TCC3: Test 3. This number will reset to TCC0 when 1) no additional tempo-
rary Fault Simulation commands are given before the Sequence Reset timer expires or 
2) at the end of a permanent fault simulation. 
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Simulate Temporary Fault. Click on the green Simulate Temporary Fault button to 
simulate a temporary fault. 

The main power supply capacitors will start to charge, and the Simulation Status 
field will display “Charging Caps.” The blue Main Caps Charge indicator at the bottom of 
the screen will start to fill up the empty space. The vacuum interrupter contacts will open 
after the main capacitors are fully charged. When the interrupter contacts are open, the full 
blue “Main Caps Charge” bar recedes immediately. See Figure 137 for an example of what 
is displayed on the Functional Test screen during the open interval.

Figure 137 . The status during functional test open interval .

The vacuum interrupter contacts will reclose after the configured open-interval 
time has elapsed, and the operating sequence will step to the next Trip operation; the 
TripSaver II recloser is now ready for another fault simulation. Perform another temporary 
fault simulation by clicking on the button again before the sequence-reset time expires. 
Otherwise, the sequence step will reset back to the initial-trip curve. 

When the sequence step reaches the last configured Trip operation, an additional 
temporary fault simulation within the sequence reset time will release the drop-open mech-
anism and the TripSaver II recloser will drop open.
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Simulate Permanent Fault. Click on the green Simulate Permanent Fault button to 
simulate a permanent fault. 

NOTICE

For TripSaver II reclosers with firmware version 1 .7 or previous, make sure the 
trunnion of the recloser is pointing up when performing testing . Performing testing with 
the trunnion facing down or pointing to the side may cause the TripSaver II recloser 
to enter the Service Now state and display the Service Now screen . See the “End of 
Interrupting Capability and Service Now Screen” topic in the “Troubleshooting” section 
of S&C Instruction Sheet 461-502 and the “Clearing the Service Now LCD Screen” 
section on page 115 .

Similar to the temporary fault simulation, the main power supply capacitors will start 
to charge first, and the Simulation Status field will display “Charging Caps.” After the 
main capacitors are fully charged each time, the TripSaver II recloser will open and reclose 
based on the configured operating sequence and eventually release the drop-open mecha-
nism. The TripSaver II recloser will then drop open and reset.

Clicking on the Simulate Permanent Fault button before the sequence-reset time 
expires after a temporary fault simulation is performed will immediately start a permanent 
fault simulation from the beginning of -TCC0.

NOTICE

Clicking either of the two green fault-simulation buttons when in NR or R-NR mode 
or when only the Initial Trip curve is applied will cause the recloser to operate a single 
shot to drop open .

Note: To properly simulate a Drop Open operation, the TripSaver II recloser must be 
installed in a present-production (“-R10” or “-R11”) S&C cutout mounting. In the absence 
of a cutout mounting, always place the TripSaver II recloser horizontally on a flat surface 
with the trunnion pointing up when simulating a permanent fault. The recloser will still go 
through the entire sequence and release the drop-open mechanism at the end. However, 
the drop-open mechanism must be reset manually by either pulling up on the trunnion or 
by installing the TripSaver II recloser into a cutout mounting. The drop-open mechanism is 
fully reset when the trunnion is no longer loosely movable. The Functional Test feature 
was not designed to simulate the “Iced-on-the-pole” scenario when a TripSaver II recloser 
is powered by the service center configuration power module. Do not hold the TripSaver II 
recloser in the mounting after the drop-open mechanism has been released when using a 
power module.

Abort Simulation. Click on the yellow Abort Simulation button to stop the ongoing 
simulation. The blue “Main Caps Charge” bar recedes after this button is clicked. See 
Figure 137 on page 100.
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How the Local Manual Open Works 
TripSaver II reclosers loaded with firmware version 1.6 and later have a Local Manual 
Open (LMO) feature for loadbreaking without the use of the Loadbuster®—The S&C 
Loadbreak Tool. When enabled, this feature provides a manual operation sequence that 
commands the TripSaver II recloser to open the vacuum interrupter contacts and drop 
open. A TripSaver II recloser must be powered and installed vertically in a cutout mounting 
for the LMO feature to work.

The MODE-SELECTOR lever controls the LMO feature. The Open command state is 
triggered by operating the MODE-SELECTOR lever X number of times within a Y-second 
window when the TripSaver II recloser is in the vertical position. 

When the triggering condition has been met, the TripSaver II recloser starts the open 
time-delay sequence. For the next 10 seconds, an “LMO Cancel?” prompt will appear on 
the LCD screen for cancellation. The LMO command can be canceled by any operation of 
the MODE-SELECTOR lever. If the MODE-SELECTOR lever is operated during this time, 
an “LMO Canceled” message will briefly appear on the LCD screen to indicate the user has 
canceled the operation. 

If the command is not canceled within 10 seconds, a “WALK AWAY” message will 
display on the LCD screen, indicating the start of the 20-second operation timer intended 
to allow the operator to comply with any operating-distance requirements specified by the 
utility work practices. 

During the walk-away period, the operator can no longer cancel the Open operation. 
At the end of the walk-away period, the TripSaver II recloser will open the vacuum-inter-
rupter contacts to interrupt the load current, then drop open and reclose the contacts after 
the tilt sensor indicates a completed drop-open function. See Figure 138 for a flowchart of 
the LMO feature sequence. 

Recloser 
normal 
state

10-second 
cancellation 

window

20-second 
walk-
away 

window

Recloser 
breaks 

load and 
drops 
open

Operate 
lever X times 

within 
Y-second 
window

Triggering condition not met

Triggering 
condition met

Any lever movement

LMO 
executes

Figure 138 . The LMO feature sequence .

It is important to keep in mind the following:

 ● When the LMO feature is enabled, a new LCD screen titled “LMO” will be automati-
cally displayed under the LCD scrolling screen sequence as its first scrolling screen, 
with the X value shown on the left and the Y value shown on the right. This screen is 
not displayed when the LMO feature is disabled.

Local Manual Open 
Settings Screen
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 ● The mode-selector Operation counter registers a single movement starting either in 
the Up or Down position of the lever as an operation. Moving the lever down and then 
back up would be counted as two operations.

 ● If the operation time window (Y) expires before (X) lever operations are completed, 
the command sequence will be terminated. The Operation counter will reset to zero; 
any additional lever operations will begin the count toward a new command sequence.

 ● If the TripSaver II recloser detects a fault while a user is performing the LMO 
command, the command sequence will reset before the recloser trips, and the 
protection sequence of the TripSaver II recloser will operate normally. The Reclose/
Non-Reclose function will be selected based on the operating lever position at the 
time the TripSaver II recloser trips. Figure 139, Figure 140, Figure 141, Figure 142 on 
page 104 and Figure 143 on page 104 show how the LCD screens appear.

 ● LMO events will be recorded in the Event log.

When the LMO feature is disabled, the TripSaver II recloser will not drop open, 
no matter how many times the MODE-SELECTOR lever is operated. However, if 10 
MODE-SELECTOR lever operations are detected within a 60-second time frame when 
the mode is disabled and the recloser is in the vertical position, the recloser will display a 
screen showing “LMO XXXXX” to remind the line crew the LMO feature is disabled (see 
Figure 143 on page 104). 

At the same time, to maximize system security, the recloser will consider that as 
a suspicious malicious attempt, and if the TripSaver II recloser is connected to remote 
communications, the recloser will send an unsolicited alert. This activity will also be 
recorded in the event log.

Figure 139 . The LMO is enabled with the operations count and time window .

Figure 140 . The prompt screen for LMO feature cancellation .

Figure 141 . The confirmation screen that LMO feature is canceled .
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Figure 142 . The Walk Away screen .

Figure 143 . The Suspicious Attempt screen .

User-Configurable Inputs
User configuration inputs for the Local Manual Open feature are shown in Figure 144.

Figure 144 . The Local Manual Open Settings screen .

Operation Count (X). Enter an integer to specify the LMO trigger condition. (Minimum 
value: 6; maximum value: 16)

Operation Time Window, s (Y). Enter an integer to specify the time window within 
which the LMO command sequence must be completed or it will expire. (Minimum value: 
30 seconds; maximum value: 180 seconds; increment: 10 seconds) 

Disabling LMO. “0” is accepted as a valid entry for both of these two user-configurable 
fields. The LMO function can be disabled by setting either or both values to “0.” The 
factory default setting for the Standalone (offline) mode is the Disabled state, with both 
fields set to “0.” All TripSaver II reclosers will leave S&C factory with the LMO feature 
disabled unless specified otherwise via S&C optional factory programming.
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The Communication Settings screen is where the TripSaver II recloser’s Communica-
tion mode and where the Side-Magnet Radio Enabling function are configured. See 
Figure 145.

Figure 145 . The Communication Settings screen .

Communication Mode 
The Communication mode is used to enable or disable a TripSaver II recloser with the 
Extended Open Interval option’s (option “-O”) ability to communicate with a TripSaver® 
II Communications Gateway. When connected to a TripSaver II recloser, select the desired 
Communication mode–either the Gateway Mode or Non-Gateway Mode setting—from 
the drop-down menu and click the Apply button on the menu bar or the Apply Communi-
cation Mode button. See Figure 146.

Figure 146 . The Communication Mode option menu .

Communication 
Settings Screen
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NOTICE

How to use the Apply Communication Mode button:

The Apply Communication Mode button has been newly added to assist in the 
following two situations: when changing an installed TripSaver II recloser from the 
Non-Gateway Mode to the Gateway Mode setting in the field, or when encountering 
gateway commissioning difficulties and toggling from the Gateway Mode to the 
Non-Gateway Mode setting and back to the Gateway Mode setting is required . 

This button is meant to be a quick way of changing both the Communication 
Mode and the Side-magnet Radio Enabling Function settings . To change 
the communication mode and apply other settings at the same time (TCC, NR, 
Sectionalizing, etc .), click on the Apply button on the menu bar . 

When the Gateway Mode setting is enabled, the Side-magnet Radio Enabling 
Function setting will be automatically disabled, and its menu field will become blank 
and grayed out . 

The Communication mode is automatically set to the Non-Gateway Mode setting 
for the standard 5s open interval recloser, and the field is hidden because the standard 5s 
model is unable to communicate with a TripSaver II Communications Gateway. The Side-
magnet Radio Enabling Function setting is still available.

When placed in the Gateway Mode setting, a TripSaver II recloser with the extended 
open interval will no longer be able to communicate directly to a PC when a side magnet 
is attached, and the Side-magnet Radio Enabling Function setting will be disabled, 
and the Side-magnet Radio Enabling Function menu will be blank and grayed out. 
The recloser will, however, still be able to communicate directly to a PC when the service 
center configuration power module or cordless power module is attached.

When the service center configuration software is in Standalone mode, the default 
Communication Mode setting is Non-Gateway Mode. When creating a setpoint file, the 
Gateway Mode setting can be saved to the setpoint file by selecting it and clicking on the 
Save Setpoints button on the menu bar. When a snapshot file from a TripSaver II recloser 
model with the extended open interval capability is open, the state of the associated 
TripSaver II recloser’s communications mode will be shown. 

All TripSaver II reclosers are factory-set to the Non-Gateway Mode setting unless 
specified otherwise via optional factory programming. Always select the Non-Gateway 
Mode setting on the TripSaver II recloser configuration worksheet (Form 888) and in 
the user-provided setpoints file when requesting factory programming for standard 5s 
TripSaver II reclosers.

NOTICE

When the service center configuration software is communicating with a TripSaver II 
recloser via the communications gateway, the Firmware Update function will be 
disabled . Firmware updates can only be done using the USB transceiver from the 
service center configuration kit .
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Side-Magnet Radio Enabling Function
Use the drop-down list to enable or disable the Side-magnet Radio Enabling Function 
setting and click on the Apply button on the menu bar. See Figure 147. The Side-magnet 
Radio Enabling Function setting, which works only under the Non-Gateway Mode 
setting, is described in more detail in S&C Instruction Sheet 461-507, “Enabling Pole‑Top 
Communication via the TripSaver II Magnet Tool.” 

Figure 147 . The Side-Magnet Radio Enabling Function option .

The default setting for the Standalone mode is “Enabled.” All TripSaver II reclosers 
will leave the S&C factory with the function enabled unless optional factory programming 
specifies otherwise. When disabled, placing a side-magnet on the recloser will not estab-
lish communication directly between a TripSaver II recloser and a PC, even when the 
TripSaver II recloser is powered. The TripSaver II recloser will, however, still be able to 
communicate directly to a PC when removed from the pole and using the service center 
configuration power module or on the pole using the cordless power module.

This setting field is not available for selection and will be grayed out when the 
Gateway Mode setting under Communication mode is selected. When placed in the 
Gateway Mode setting, a TripSaver II recloser with the Extended Open Interval 
option is only able to communicate directly to a communications gateway and is unable to 
communicate directly to a PC when a side-magnet is attached. The recloser will, however, 
still be able to communicate directly to a PC when the service center configuration power 
module is attached. 



Informational and Settings Screens

108  S&C Instruction Sheet 461-504  .

R-NR Reset
TripSaver II reclosers with the Extended Open Interval option (“-O”) can communicate 
with the TripSaver II Communication Gateway, and the user can remotely set the recloser 
to Remote Non-Reclose (R-NR) operational mode and back to Auto mode when the 
MODE SELECTOR lever is in the Up position. To avoid a situation where the TripSaver II 
recloser is permanently stuck in the R-NR mode when remote communications are not 
available, the user can set the operational mode back to the Auto setting locally by using 
the R-NR Reset feature when a TripSaver II recloser is connected to the S&C TripSaver II 
Service Center Configuration Software. See Figure 148. 

Figure 148 . The R-NR Functions screen .

The feature will be hidden for standard 5s TripSaver II reclosers that do not have the 
Extended Open Interval option capability. The operational mode will always be in the 
Auto setting when the lever is in the Up position.

Mode when lever is up. This indicates the state of the operational mode when the lever 
is in the Up position. The Reset function is only available when this field displays “R-NR.”

Set Mode to AUTO. Click on this button to set the operational mode when the lever is 
in the Up position back to the Auto setting from R-NR mode. When the mode is set to the 
Auto setting, the button will be grayed out and no longer available for clicking. Note: This 
feature does not allow users to set the recloser to R-NR mode from Auto mode locally. 
Also, changing the connection to Non-Gateway mode does not automatically reset the 
recloser to Auto mode from R-NR mode.

R–NR Functions 
Screen
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Temp Auto
A SCADA communication can place a TripSaver II recloser with the Extended Open 
Interval option (“-O”) into the Remote-Non-Reclose (R-NR) mode when remote 
communications are enabled via the TripSaver II Communications Gateway. After the 
recloser drops open under R-NR mode, the recloser will operate in Auto mode if it is 
closed into its mounting with the MODE-SELECTOR lever in the Up position for a period 
of five minutes after re-energization. This is called Temporary Auto mode.

This Temporary Auto mode can be disabled by clicking on the Disable Temporary 
Auto Post-Fault Wakeup mode in Remote-NR button. With Temporary Auto mode 
disabled and the recloser in R-NR mode, the recloser will use the NR Curve settings  
instead. See Figure 149. 

Figure 149 . Enable or disable Temporary Auto mode when the recloser is in R-NR mode .

For more information, see Appendix D, “Understanding the Active TCC Curve When 
the TripSaver II Recloser is in R-NR Mode” on page 136.

The Gateway Drop Open screen is used with the S&C TripSaver II Communications 
Gateway to allow the TripSaver II recloser to drop open by means of a local signal from 
the TripSaver II Communications Gateway. It can only be used if the TripSaver II recloser 
has been configured using the Gateway Mode setting under the Communication Settings 
screen and is communicating with a TripSaver II Communications Gateway, and if the 
appropriate settings for Gateway Drop Open mode are configured in the communica-
tions gateway. See S&C Instruction Sheet 461-509, “TripSaver® II Communications Via 
Gateway: Installation, Operation, and Configuration,” for more details on configuring the 
TripSaver II recloser to work in Gateway Drop Open mode. 

Gateway Drop 
Open Screen 
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When the service center configuration software is connected to the TripSaver II 
recloser via the USB transceiver and power module, the status of the TripSaver II recloser’s 
Gateway Drop Open configuration will appear in the Gateway Drop Open Settings screen 
when the software is in the Connected mode. See Figure 150. 

Figure 150 . The Gateway Drop Open Settings screen, when connected via USB transceiver . 

When connected to the service center configuration software via the communications 
gateway instead of the USB transceiver and power module, Disable and Enable buttons 
will be visible. The Gateway Drop Open feature can be enabled or disabled using these 
buttons. See Figure 151. 

Figure 151 . The Gateway Drop Open Settings screen, when connected via communications 
gateway .
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Note: Disabling or enabling the Gateway Drop Open feature in the service center 
configuration software’s Gateway Drop Open Settings screen will disable or enable the 
recloser’s Gateway Drop Open mode in the communications gateway. See S&C Instruc-
tion Sheet 461-509, “TripSaver® II Communications Via Gateway: Installation, Operation, 
and Configuration,” for more information.

The Remote Drop Open feature is only available for TripSaver II reclosers supplied with 
the Extended Open Interval option (“-O”) and firmware versions 1.8 and later and for 
reclosers that have also been ordered with the Remote Drop Open option (“-D”) facto-
ry-enabled.  

The TripSaver II recloser must be properly paired with a TripSaver II Communications 
Gateway, and it must be properly configured to accept a Drop Open command in response 
to a DNP3 command received via the connected SCADA transceiver. Note: The DNP 
Remote Drop Open screen is also used when the communications gateway has been set to 
use the IEC104 protocol. For detailed instructions for proper configuration of the Remote 
Drop Open feature in the TripSaver II recloser and the communication gateway, see S&C 
Instruction Sheet 461-509, “TripSaver® II Communications via Gateway: Installation, 
Operation, and Configuration.”

When Connected to the Service Center Configuration 
Software via the USB Transceiver
When the TripSaver II Service Center Configuration Software is connected to the 
TripSaver II recloser via the USB transceiver and power module, the status of the 
TripSaver II recloser’s Remote Drop Open configuration will appear in the DNP Remote 
Drop Open screen when the software is in Connected mode. See Figure 152. 

Figure 152 . The DNP Remote Drop Open screen, when connected via the USB transceiver .

DNP Remote Drop 
Open Screen
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When Connected to the Service Center Configuration 
Software via the Communication Gateway
When connected to the TripSaver II Service Center Configuration Software via the 
TripSaver II Communications Gateway instead of the USB transceiver, the Disable and 
Enable buttons will be visible. The DNP Remote Drop Open feature can be enabled or 
disabled using these buttons. See Figure 153. 

Note: Disabling or enabling the DNP Remote Drop Open feature from the service 
center configuration software’s DNP Remote Drop Open screen will disable or enable 
DNP Remote Drop Open mode in the communication gateway. See S&C Instruction 
Sheet 461-509, “TripSaver® II Communications via Gateway: Installation, Operation, and 
Configuration,” for more information about configuring this feature.

Figure 153 . The DNP Remote Drop Open screen, when connected via the communication 
gateway .
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Troubleshooting

Having a low signal strength between the TripSaver II recloser and the USB transceiver can 
cause delays in updating settings and extended firmware update times. If experiencing low 
signal quality when connected to a TripSaver II recloser using the USB transceiver and the 
service center configuration software, move the powered TripSaver II recloser between 
one to 4 inches (25 to 102 mm) away from the USB transceiver, with the recloser facing 
down and the trunnion pointing up and with the LCD screen toward the USB transceiver at 
an approximate 45˚ angle. See Figure 154.

Figure 154 . Placement of the TripSaver II recloser in relation to the USB transceiver .

Service center configuration software version 2.1x in combination with the USB trans-
ceiver with enhanced antenna (part number FDA-1868R2) significantly improves signal 
strength

Note: For more information on signal quality and the signal strength indicator, see the 
“Additional Information Bar” section on page 20.

Table 3 details the USB transceiver’s LED indicators and their meaning. See Figure 155.

Figure 155 . LED indicators on the USB Transceiver .

Table 3 . USB Transceiver LED Indicators

LED Indicators Condition

Green (constant) Power is On .

Red (fast-blinking) The USB transceiver is transmitting data . Fast-blinking during the connecting 
stage indicates the connection is successful and about to complete . 

Red (slow-blinking) The USB transceiver is attempting to connect to a TripSaver II recloser .

Red (Constant)

USB transceiver is in the Error state . If the red LED is on constantly, the USB 
transceiver should be reset . (See the “If Connection Process Displays a Timeout 
Message” section on page 114 for directions on how to reset the USB trans-
ceiver .)

Optimizing 
Signal Strength

Understanding 
the LED Indicators 
on the USB 
Transceiver
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When attempting to connect a TripSaver II recloser using the service center configura-
tion software, the connection process will timeout if it is unable to create or maintain 
a wireless connection. See Figure 156. This is generally caused by low signal strength, 
which can be a result of distance, orientation of the product, interference from other 
signal sources, or a combination of these. A USB transceiver is available with an enhanced 
external antenna to improve signal strength. 

Figure 156 . Timeout message .

STEP 1 . Remove sources of interference. Wi-Fi and Bluetooth operate in the same 
2.4-GHz frequency band as the USB transceiver. Before clicking on the Retry 
button, disable the computer’s Wi-Fi and Bluetooth adapters. If possible, 
disable nearby Wi-Fi and Bluetooth devices. If Wi-Fi is required for the laptop, if 
possible, disable the 2.4-GHz band and use a 5-GHz connection. 

Keep any powered TripSaver II reclosers not being configured at least 
30 feet (914 cm) away from the TripSaver II recloser being configured, or 
power off any TripSaver II reclosers not being configured. Also power off any 
TripSaver II Communications Gateways near the TripSaver II recloser.

STEP 2 . Optimize the TripSaver II recloser’s placement. Make sure the TripSaver II 
recloser is positioned as described in the “Optimizing Signal Strength” section on 
page 113. 

STEP 3 . Reattempt connecting to the TripSaver II recloser. If the Timeout message (see 
Figure 156) persists or an Object Error message (see Figure 157) appears, (this 
may be noticeable more often when connection to consecutive TripSaver II 
reclosers using the same computer), reset the USB transceiver.

Figure 157 . Object error message .

If Connection 
Process Displays a 
Timeout Message
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STEP 4 . Reset the USB transceiver.

(a) Click on the Cancel button when the error message displays.

(b) Unplug the USB transceiver. Disconnect the power module from the 
TripSaver II recloser being configured and wait 15 seconds for it to 
completely power down.

(c) Close the service center configuration software.

(d) Plug back in the USB transceiver.

(e) Restart the service center configuration software.

(f) Re-connect the power module to the TripSaver II recloser to be configured.

(g) Re-establish communications with the TripSaver II recloser using the config-
uration software.

If still having connection problems, contact the S&C Global Support and Monitoring 
Center at 1-888-762-1100.

The SERVICE NOW LCD screen can appear because of these circumstances:

 ● When a TripSaver II recloser is blocked from swinging to the Drop Open position for 
five consecutive attempts, when commanded to drop open either by a Fault operation, 
a Gang operation, a Local-Manual Open (LMO) operation, or a Remote operation 
(This condition might occur when the recloser is iced into the cutout mounting or 
otherwise held in the cutout mounting when attempting to drop open.)

 ● When a functional test of the TripSaver II recloser is performed with the trunnion 
facing down or to the side for five consecutive drop-open attempts (Note: The only 
acceptable position for the recloser to be in during a functional test is with the 
trunnion pointing up. These orientation issues will not affect TripSaver II reclosers 
with firmware version 1.8 or later.)

 ● When test current is applied to the recloser terminals simulating a permanent fault for 
five consecutive drop-open attempts (Note: The only proper bench-testing orientation 
for the TripSaver II recloser is with the trunnion pointing up. These orientation issues 
will not affect TripSaver II reclosers with firmware version 1.8 or later.)

 ● When the vacuum interrupter contact wear is at 0%

When a TripSaver II recloser enters the Service Now state, the LCD screen will be 
locked with a special Service Now screen. The right side of the screen will display the 
vacuum interrupter status (“O” for open, “I” for closed, and “X” for an error situation 
when the recloser cannot sense the vacuum interrupter status). The left side of the screen 
will display an “!” symbol, indicating immediate attention is needed. Rotating the MODE 
SELECTOR lever, applying a 9-Volt lithium L522 battery, or applying the power module will 
not unlock the state.

Clearing the 
Service Now 
LCD Screen
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To clear the SERVICE NOW LCD screen because of five consecutive improper orienta-
tion drop open attempts, follow these steps:

STEP 1 . Connect to the TripSaver II recloser using the service center configuration 
software. Instructions for connecting to the software are explained in the 
“Connect to Device” section on page 29.

STEP 2 . Confirm the TripSaver II recloser is in the Service Now state by checking the 
Status screen. Then, check the Remaining Contact Wear field. If the remaining 
contact wear is 0%, the TripSaver II Cutout-Mounted Recloser should be taken 
out of service. If it is greater than 0%, continue with Step 3. See Figure 158.

STEP 3 . Create a snapshot file by clicking on the Save Snapshot icon. See Figure 158. 
Contact S&C through the Global Support and Monitoring Center at 1-888-762-
1100. The support technician will request the snapshot file via email. 

Figure 158 . The Status screen showing the Service Now status and the location of the Save 
Snapshot icon .
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STEP 4 . S&C will return the repair ATXReset.xml file. Place the repair file in the default 
Log File Directory. To find the default Log File Directory, select “Tools>Options” 
on the Main menu. See Figure 159 and Figure 160.

Note: If clearing the Service Now status on multiple TripSaver II reclosers, it is 
important not to mix up repair files. Each repair file is only good for the snapshot 
file it was made from. S&C recommends clearing the Service Now status from 
affected reclosers one at a time, deleting the repair file after each successful 
attempt. The repair file “ATXReset.xml” is good for 24 hours. S&C recommends 
completing the Clear “Service Now” process as soon as the repair file is 
received. If the file expires, contact the Global Support and Monitoring Center 
for a new one.

Figure 159 . The default Log File Directory .

Figure 160 . The location of the repair file will be the default Log File Directory .
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STEP 5 . From the Tools menu, click on the Clear ‘Service Now’ menu item. See 
Figure 161. 

Figure 161 . The Clear Service Now menu item on the Tools menu .
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STEP 6 . The Clear Service Now dialog box will appear with the following message:

“Before proceeding with the Service Now Reset procedure, the 
TripSaver II Cutout-Mounted Recloser must be placed on a workbench in the 
horizontal position with the trunnion pointing up.” See Figure 162.

Figure 162 . The Clear Service Now dialog box .

“The TripSaver II recloser must be continuously powered with the ac power 
module until a Permanent Fault simulation is completed. If the recloser is 
disconnected from power at any time during the procedure, the Service Now 
Reset procedure will not be successful.”

After confirming the TripSaver II recloser is in the horizontal position with 
the trunnion pointing up, and it is powered with the ac adapter, click on the Ok 
button. 
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STEP 7 . The Clear Service Now–Final Step dialog box will appear. See Figure 163. Click 
on the Ok button. 

Figure 163 . The Clear Service Now—Final Step dialog box .

If the TripSaver II recloser is at 0% contact wear: A dialog box will 
appear explaining the Service Now state cannot be cleared. 

“This Recloser cannot be repaired and must not be reused. This ends the 
Clear Service Now process for this recloser.”

If the TripSaver II recloser is not at 0% contact wear: A dialog box 
will appear advising the user to proceed to the Functional Test screen. Go to the 
Functional Test screen and click on the Simulate Permanent Fault button. 

The TripSaver II recloser will go through the permanent fault simulation, 
and a loud click will sound when it has completed. Pull up on the trunnion after 
the test has completed to reset the drop-open mechanism. 

Go to the Connection menu and click on the Disconnect menu item. 
Disconnect power to the TripSaver II recloser by removing the power module. 
Then, reconnect power to the TripSaver II recloser by replacing the power 
module and reconnect to it using the method described in “Connect to Device” 
section on page 29.
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STEP 8 . Navigate to the Status screen and check the status of the TripSaver II recloser. 
If the Status is OK, the Service Now status has been cleared. See Figure 164. 
Then, delete the ATXReset.xml file from the default log file directory. See 
Figure 160 on page 117. If the Service Now status is still present, contact the 
S&C Global Support and Monitoring Center at 1-888-762-1100.

Figure 164 . The Status screen after a successful Clear Service Now reset procedure .
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 TripSaver II reclosers that have experienced connection issues during a firmware update 
may lose their profile data. This can include serial number information, catalog number 
information, all programmed settings, and an incorrect continuous current rating. This 
condition can occur when:

 ● Signal interference is encountered during a firmware update

 ● Power to the TripSaver II Cutout-Mounted Recloser is lost during the firmware update

S&C strongly recommends only doing a firmware update with the TripSaver II recloser 
removed from the pole, on a workbench, and with the corded power module providing 
power to the TripSaver II recloser. Never use the cordless power module during a 
firmware update. S&C also recommends performing firmware updates in an area free from 
signal interference. See the “Optimizing Signal Strength” section on page 113 for more 
information.

An example Status screen of a profile before and after data loss is shown in Figure 165 
and Figure 166 on page 123.

Figure 165 . A TripSaver II recloser profile before a firmware update .

Restoring Profile 
If Lost During a 
Firmware Update
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Figure 166 . A TripSaver II recloser profile after profile data has been lost . Lost settings are 
noted within the red boxes .

If profile data are lost during a firmware update, the information can be recovered 
from the snapshot file the service center configuration software creates before the 
firmware update. To restore profile data, follow these steps:

STEP 1 . Download and install SCC 2.1 software on the laptop. 

STEP 2 . Launch SCC 2.1 software and connect to the TripSaver II recloser. 

STEP 3 . Navigate to Tools>Restore menu item. See Figure 167.

Figure 167 . The Restore Profile menu item in the Tools menu .
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STEP 4 . When prompted, navigate to the snapshot (.xdss) file in the Documents>S&C 
Electric>Products>TripSaver II folder and choose the most recent snapshot file 
having the TCMR number matching the TripSaver II recloser being restored. See 
Figure 168.

Figure 168 . Snapshot files in the Documents>S&C Electric>Products>TripSaver II folder .

Note: If the firmware update was done with service center configuration 
software version 1.9 or earlier, S&C recommends opening the snapshot (.xdss) 
file in Microsoft Notepad to determine whether the TCMR number in the 
snapshot file matches the TCMR etched on the TripSaver II recloser being 
restored. (The serial number for the TripSaver II recloser (TCMR-) is etched on 
the recloser housing.) It is important not to alter the snapshot file when opened 
because doing so may have an adverse impact on the restoration process. See 
Figure 169.

Figure 169 . The Snapshot file opened with Notepad .
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If your company uses OneDrive, the location will follow the format:

C:\Users\<USER>\OneDrive – (users company name)\Documents\S&C Electric\
Products\TripSaverII file path.

To check the snapshot file using Notepad: Navigate to the Documents>S&C 
Electric>Products>TripSaver II folder. If several TripSaver II reclosers have 
been updated, more than one snapshot file could be in this folder. Open the 
snapshot file using Microsoft Notepad. From the Edit menu, select the Find 
menu item and search for “TCMR.” Match this to the TripSaver II recloser to 
which the profile data is to be restored. See Figure 169 on page 124. Close the 
snapshot file without saving any changes.

STEP 5 . After selecting the snapshot file, the Restoring Profile dialog box will open. Click 
on the OK button. A “Success” message will appear when the profile restoration 
is complete. See Figure 170.

Note: If the correct snapshot file cannot be found, have whoever tried to 
perform the firmware upgrade log in to the laptop with their credentials. The 
snapshot file may not be showing up in the file directory under the user’s profile 
credentials. It instead could the person who was logged in to the computer. 

Figure 170 . The Restoring Profile dialog box .



Troubleshooting

126  S&C Instruction Sheet 461-504  .

STEP 6 . Check the Status screen to make sure the profile information has been success-
fully restored. See Figure 171.

Figure 171 . The Status screen after a successful profile restoration .
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Appendix A

List of Available Curves

Table 4 . Cooper

Cooper Microprocessor Form 4,5,6, FX

Inverse Segment Definition

S&C 101 Cooper 101

S&C 102 Cooper 102

S&C 103 Cooper 103

S&C 104 Cooper 104

S&C 105 Cooper 105

S&C 106 Cooper 106

S&C 107 Cooper 107

S&C 111 Cooper 111

S&C 112 Cooper 112

S&C 113 Cooper 113

S&C 115 Cooper 115

S&C 116 Cooper 116

S&C 117 Cooper 117

S&C 118 Cooper 118

S&C 119 Cooper 119

S&C 120 Cooper 120

S&C 132 Cooper 132

S&C 133 Cooper 133

S&C 134 Cooper 134

S&C 135 Cooper 135

S&C 137 Cooper 137

S&C 138 Cooper 138

S&C 142 Cooper 142

S&C 151 Cooper 151

S&C 161 Cooper 161

S&C 162 Cooper 162

S&C 163 Cooper 163

S&C 165 Cooper 165

S&C 201 Cooper 201

S&C 202 Cooper 202

Table 5 . SEL

SEL 351R/651R Recloser Control

Inverse Segment Definition

SEL U1 SEL U1 Moderately Inverse

SEL U2 SEL U2 Inverse

SEL U3 SEL U3 Very Inverse

SEL U4 SEL U4 Extremely Inverse

SEL U5 SEL U5 Short-Time Inverse

SEL C1 SEL C1 Standard Inverse

SEL C2 SEL C2 Very Inverse

SEL C3 SEL C3 Extremely Inverse

SEL C4 SEL C4 Long-Time Inverse

SEL C5 SEL C5 Short-Time Inverse

Table 6 . ABB

ABB DPU 2000R Recloser Control

Inverse Segment Definition

ABB INV ABB Inverse

ABB VI ABB Very Inverse

ABB EI ABB Extremely Inverse

ABB STI ABB Short-Time Inverse

ABB STEI ABB Short-Time Extremely Inverse

Table 7 . IEC

IEC Standard Curve

Inverse Segment Definition

IEC SI IEC Standard Inverse

IEC VI IEC Very Inverse

IEC EI IEC Extremely Inverse

Table 8 . IEEE

IEEE Standard Curve

Inverse Segment Definition

IEEE EI IEEE Extremely Inverse

IEEE MI IEEE Moderately Inverse

IEEE VI IEEE Very Inverse

LIST OF CURVES CONTINUED ▶



Appendix A

128  S&C Instruction Sheet 461-504  .

Table 9 . Fuse Link

Ampere Rating

K- 
Speed

T- 
Speed

QA/QR KS
NE (N-Speed 

McGraw- Edison)
NK (N-Speed 

Kearney)
ST① CO②

6K 6T 3QR 10KS 5NE 5NK 5ST 101CO

8K 8T 5QR 15KS 8NE 7NK 7ST 102CO

10K 10T 7QR 20KS 10NE 10NK 10ST 103CO

12K 12T 8QR 25KS 15NE 15NK 15ST

15K 15T 10QR 30KS 20NE 20NK 20ST

20K 20T 15QR 40KS 25NE 25NK 25ST

25K 25T 20QR 50KS 30NE 30NK 30ST

30K 30T 25QR 65KS 40NE 40NK 40ST

40K 40T 30QR 80KS 50NE 50NK 50ST

50K 50T 40QR 100KS 60NE 65NK 65ST

65K 65T 50QR 125KS 75NE 80NK 80ST

80K 80T 60QR 150KS 85NE 100NK 100ST

100K 100T 75QR 200KS 100NE 125NK 125ST

140K 140T 100QR 125NE 150NK 150ST

200K 200T 125QR 150NE 175NK 200ST

150QR 200NE 200NK

175QR

200QR

① ST curves are S&C Standard Fuse emulation curves . ② CO curves are S&C Coordinating Fuse emulation curves .

LIST OF CURVES CONTINUED ▶
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Table 10 . Hydraulic Recloser

Type Inverse Segment Definition Coil Rating

Type 4H, V4H

(V)4H-A● Type 4H or Type V4H, A curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

(V)4H-B Type 4H or Type V4H, B curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

(V)4H-C Type 4H or Type V4H, C curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

Type H

H-A● Type H, A curve 5A, 10A, 15A, 25A, 35A, 50A

H-B Type H, B curve 5A, 10A, 15A, 25A, 35A, 50A

H-C Type H, C curve 5A, 10A, 15A, 25A, 35A, 50A

Type L

L-A● Type L, A curve 25A, 35A, 50A, 70A, 100A, 140A, 200A

L-B Type L, B curve 25A, 35A, 50A, 70A, 100A, 140A, 200A

L-C Type L, C curve 25A, 35A, 50A, 70A, 100A, 140A, 200A

L-D Type L, D curve 25A, 35A, 50A, 70A, 100A, 140A, 200A

Type V4L, V4E

V4L(E)-A● Type V4L or Type V4E, A curve 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

V4L(E)-B Type V4L or Type V4E, B curve 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

V4L(E)-C Type V4L or Type V4E, C curve 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

V4L(E)-D Type V4L or Type V4E, D curve 15A, 25A, 35A, 50A, 70A, 100A, 140A, 200A

Type E

E-A● Type E, A curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A

E-B Type E, B curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A

E-C Type E, C curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A

E-D Type E, D curve 5A, 10A, 15A, 25A, 35A, 50A, 70A, 100A

Type 4E

4E-A● Type 4E, A curve 50A, 70A, 100A, 140A, 200A

4E-B Type 4E, B curve 50A, 70A, 100A, 140A, 200A

4E-C Type 4E, C curve 50A, 70A, 100A, 140A, 200A

4E-D Type 4E, D curve 50A, 70A, 100A, 140A, 200A

Type DV

DV-A● Type DV, A curve 100 A, 140 A

DV-B Type DV, B curve 100 A, 140 A

DV-C Type DV, C curve 100 A, 140 A

DV-D Type DV, D curve 100 A, 140 A

DV-E Type DV, E curve 100 A, 140 A

● Curves are available that emulate both the Maximum Clearing Time 
and the Average Clearing Time .
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Appendix B

Normal Operation LCD States
The LCD states listed in Table 11 are the normal operation of a TripSaver II recloser. TripSaver II reclosers can be 
programmed to display user-configured LCD states in sequence by toggling the LMO lever or by powering up. 

Table 11 . Normal Operation Screens

Screen Name Description

●

Primary Normal screen
For standard TripSaver II reclosers, four operating parameters are 
displayed: Vacuum interrupter status (Open or Closed), Mode 
selector status (Auto or NR) .

— Hold Previous screen 
The previous screen selected in the sequence is displayed for 
an additional period of time as defined by each Display Screen 
Duration setpoint .

●

Blue screen A blue screen is displayed .

●

Alternate Normal screen (Secondary 
Normal screen) vacuum interrupter in an 
Open state

The vacuum interrupter is in an Open state . 

●

Alternate Normal screen (Secondary 
Normal screen) vacuum interrupter in a 
Closed state

The vacuum interrupter is in a Closed state . 

●

Alternate Normal screen (Secondary 
Normal screen) vacuum interrupter is in 
an unknown state

This is an unknown vacuum interrupter state .  

●

Mode Selector Lever status The mode of operation–either Auto, NR, or R-NR–is displayed .

●

Remaining contact wear, in % The remaining vacuum interrupter contact wear, in percent, is 
displayed .

● LCD states that can be programmed to display when a TripSaver II 
recloser is in its Dropped-Open state . Only one state can be selected in 
the service center configurator software . TABLE CONTINUED ▶
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Table 11 . Normal Operation Screens—Continued

Screen Name Description

●

Load current The load current, in primary amperes, is displayed .

●

Number of Open operations The total number of vacuum interrupter Open operations is 
displayed .

●

Last fault magnitude

The fundamental-frequency magnitude of the last fault current, in 
primary amperes as measured just before the vacuum interrupter 
opens, is displayed . The fault-current unit is amperes for faults 
smaller than 1000 A and kiloamps with two decimals for faults 
greater than or equal to 1000 A . This was done because of the 
limited horizontal space on the LCD screen .

●

Vacuum Interrupter status The Open or Closed status of the vacuum interrupter is 
displayed .

●

The LCD Temperature screen . The TripSaver II recloser temperature is shown, in degrees 
Celsius . 

●

Interrupting rating The interrupter rating of the recloser, in kA, is displayed . 

●

Max-rated voltage The rated maximum voltage of the recloser; either 15 .5 kV or 
29 kV is displayed .

●

System frequency The frequency of the electrical system the TripSaver II recloser is 
configured for, in Hz, is displayed .

● LCD states that can be programmed to display when a TripSaver II 
recloser is in its Dropped-Open state . Only one state can be selected in 
the service center configurator software . TABLE CONTINUED ▶
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Table 11 . Normal Operation Screens—Continued

Screen Name Description

●

Software versions
Three pieces of information about software version are displayed: 
Application, Bootloader, and Radio Frequency Microcontroller 
Unit .

■ 

Transceiver ID This is the communication ID . Displayed when the mode selector 
is rotated . 

●

TCC #0 (initial trip) The short name for the initial trip curve is displayed .

●

TCC #1 (Test 1)
The short name for the Test 1 curve (2nd TCC curve) is 
displayed . This screen is automatically skipped if the Test 1 
operation is disabled .

●

TCC #2 (Test 2)
The short name for the Test 2 curve (3rd TCC curve) is displayed . 
This screen is automatically skipped if the Test 2 operation is 
disabled .

●

TCC #3 (Test 3)
The short name for the Test 3 curve (4th TCC curve) is displayed . 
This screen is automatically skipped if the Test 3 operation is 
disabled .

●

Sectionalizing mode counts:

This screen displays the preset number of source-side circuit 
breaker or recloser operations the TripSaver II recloser will count 
up to before dropping open . This screen is automatically skipped 
if Sectionalizing mode is disabled .

●

NR #0 (NR/Remote NR TCC curve) This is the standard NR TCC curve .

● LCD states that can be programmed to display when a TripSaver II 
recloser is in its Dropped-Open state . Only one state can be selected in 
the service center configurator software . TABLE CONTINUED ▶

● LCD states that can be programmed to display when a TripSaver II 
recloser is in its Dropped-Open state . Only one state can be selected in 
the service center configurator software .

■ Rotating the MODE SELECTOR lever initiates the display screens 
after the TripSaver II recloser is powered up . When powered up, the 
display will show the transceiver ID .

TABLE CONTINUED ▶
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Table 11 . Normal Operation Screens—Continued

Screen Name Description

●

NR #1 (Post-Fault TCC curve) This is the Post-Fault Wakeup NR TCC curve

●

NR #2 (Cold Wake-up TCC curve) This is the Cold Wakeup NR TCC curve .

●

SC#0 (sequence coordination) The Sequence Coordination TCC curve or “Disabled” is displayed

● LCD states that can be programmed to display when a TripSaver II 
recloser is in its Dropped-Open state . Only one state can be selected in 
the service center configurator software .
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Appendix C

Alternate LCD States: Fault Interruption, Local Manual Open and error conditions .

Table 12 . Fault Interruptions

Screen Name Description

 

Temporary fault (count) This is the number of fault interruptions from a transition from a 
Closed position to an Open position .

 

Dropped Out screen This is the Inverted option selected shown during a permanent 
fault

Table 13 . Local Manual Open (LMO)—Operation

Screen Name Description

LMO—local manual open The LMO feature is enabled with the operations count and time 
window .

LMO—Cancel? The Prompt screen for cancellation of the LMO feature .

 

LMO—Canceled The Confirmation screen that the LMO feature is canceled .

LMO—Aborted The Confirmation screen that the LMO feature is aborted

LMO—XXXXX The Suspicious Attempt screen .

Walk Away The Walk Away screen .
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Table 14 . Error Conditions

Screen Name Description

Overload The OVERLOAD indicator at the bottom left corner (symbol “X”) .

Service soon The SERVICE SOON indicator at the bottom right corner (symbol 
“•”) .

SERVICE NOW 
 • If the LCD screen shows the exclamation mark, the unit is in Service Now mode and will not perform any protection actions .
 • The unit must be removed from operation . Even if the unit is in the cutout mounting (not dropped out) in the Service Now condition, it will not 

perform any protection actions . The vacuum interrupter may be in an Open, Closed, or unknown state .
 • In a “normal” vacuum interrupter end-of-life situation, the unit will drop out and stay with the vacuum interrupter open and the trunnion disengaged 

(the unit will not stay in the cutout mounting in the vertical position) .  

Service Now The vacuum interrupter state is unknown .

Service Now The position of the vacuum interrupter is in an Open state .

Service Now The position of the vacuum interrupter is in a Closed state .
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Appendix D

A SCADA communication can place a TripSaver II recloser with the Extended Open 
Interval option (option “-O”) into Remote Non-Reclose (R-NR) mode if remote commu-
nications are enabled via the TripSaver II Communications Gateway. With the addition of 
the new NR-Standard, Cold Wakeup, and Post Fault Wakeup curves, and with the ability to 
turn off the Temporary Auto mode, the TripSaver II recloser may behave differently from 
what is expected. 

Table 15 explains which curve is active depending on the MODE-SELECTOR lever 
position, the R-NR mode, the conditions the recloser is “waking up” from when being 
closed into its mounting, and whether the Temporary Auto mode has been disabled under 
the R-NR Functions menu.

Table 15 . Active TCC Curve When TripSaver II Recloser Is in R-NR Mode

Settings and Conditions Active TCC Curve

Mode- 
Selector 

Lever 
Position

R-NR 
Mode①

Condition 
During 

Wakeup

Temporary 
Auto Feature 

Setting 
in R-NR 
Feature 
Menu 

Temporary 
Auto

Standard 
NR 

Cold 
Wakeup NR

Post Fault 
Wakeup NR

Up

Off

Warm – X

Cold – X

Post Fault – X

On

Warm – X

Cold – X

Post Fault
Off● X

On● X

Down

Off

Warm – X

Cold – X

Post Fault – X

On

Warm – X

Cold – X

Post Fault – X

① When the TripSaver II recloser is set to the Remote Non-Reclose (R-NR) state via SCADA .
● The Temporary Auto mode can be enabled or disabled using the Disable Temporary Auto Post-Fault 
Wakeup mode in Remote-NR button found in the R-NR Functions menu . This ONLY disables Temporary Auto 
mode when the switch is in R-NR mode with the lever in the Up position .

Understanding 
the Active TCC 
Curve When 
the TripSaver II 
Recloser is in 
R-NR Mode
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Appendix E

This document contains statements required for compliance with the rules and policies of 
various national and international regulatory agencies. The information is current as of the 
date of this publication but may be subject to change without notice. For the most recent 
version of this instruction sheet with the most up-to-date regulatory information, contact 
S&C Electric Company.

United States of America—FCC (Federal Communication Commission)
This device complies with part 15 of the FCC rules and regulations regarding unlicensed 
transmissions. Operation is subject to the following two conditions: (1) This device may 
not cause harmful interference and (2) this device must accept any interference. 

IMPORTANT! Changes or modifications not expressly approved by S&C Electric 
Company could void the user’s authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residen-
tial area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense. 

Canada—ISED (Innovation, Science & Economic Development Canada)
This device complies with Industry Canada license-exempt RSS standard(s). Operation is 
subject to the following two conditions: (1) this device may not cause interference, and (2) 
this device must accept any interference, including interference that may cause undesired 
operation of the device. 

Cet appareil est conforme aux normes Industry Canada exemptes de licence RSS 
standard(s). Son fonctionnement est soumis aux deux conditions suivantes: (1) cet 
appareil ne doit pas provoquer d’interférences et (2) cet appareil doit accepter toute 
interférence, y compris les interférences susceptibles de provoquer un fonctionnement 
indésirable. 

The changes or modifications not expressly approved by the S&C Electric Company 
could void the user’s authority to operate the equipment. 

CAN ICES-3 (A)/NMB-3(A) 

Regulatory and 
Compliance 
Statements
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Brazil (ANATEL) 
Atendimento à Regulamentação Anatel

Este equipamento não tem direito à proteção contra interferência prejudicial e não 
pode causar interferência em sistemas devidamente autorizados.

Este produto está homologado pela ANATEL, de acordo com os procedimentos regula-
mentados pela Resolução 242/2000, e atende aos requisitos técnicos aplicados.

Para maiores informações, consulte o site da ANATEL. www.anatel.gov.br

Thailand
This radiocommunication equipment is exempted to possess license, user license, or radio-
communication station license as per NBTC notification regarding radiocommunication 
equipment and radiocommunication station has been exempted for license according to 
radio communication act B.E.2498

http://www.anatel.gov.br
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